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- Specify path for installation: You can specify a path for installation. or

you can select-the default path. The default path for 32-bit operating
SyflenBisc:\Program Fi1es\Auentail\Connect

For 16-bit-only operating systems, the default is
-c:\Connecc

' NOTE: if you are upgrading from an earlier version of Aventail Connect, .
Aventail Connect will install to the same directory that the eartier
version of it was installed to. 

- Platforms: You must specify which operating systems need to be sup-
ported in the setup package. Aventail Connect 3.1 supports Windows
95 {with the Microsoft Wlnsock 2 update), Windows 98. and Windows

NT 4.0 (with Service Pack 3 or above, available from Microsoft). Aven-
tail Connect 2.6 supP()rts Windows 95 (without the Microsoft WinSock 2
update). Windows 3.1, Windows for Wontgroups 3.11, and Windows NT
3.51. For more information, refer to "What Does Aventaii Connect Do?"

- Trusted Roots File and Certificate File: if you want to use server cer-

tificates, you must include the trusted roots file that contains those oer-
tificates. If you want to use client certificates, you must specify the
location of the file that contains the X. 509 certificate.

- Running Setup in Unattended Mode: Unattended setup mode simpli-
fies distribution of numerous client configuration files. The network
administrator specifies all settings before users receive the Aventaii

Connect setup package file. No end-user input is required because the
network administrator has already selected the setup options; users

simply open the package file, which will automatically installon their
workstations.

NOTE: Specifying unattended setup mode will cause the setup package
to automatically install using default values for any options not
explicitly specified.

 

- Adding Aventail Connect to the Startup Directory: If you choose to
add Aventail Connect to the startup directory, Aventail Connect will
automatically start when Windows starts.

- Select Tools: Aventail Connect gives you the option to install various
components, including Extranet Neighborhoodisecure Extranet

Explorer (SEE), configuration tools (Config Tool and Configuration File
command). or diagnostic tools (Logging Tool and S5 Ping). The default
value is to install all package components.

- Secure Extranet Explorer: Secure Extranet Explorer (SEE) allows
you to view your Extranet Neighborhood, which is accessed through
the Extranet Neighborhood icon on your desktop. Extranet Neigh- _
borhood functions much like Network Neighborhood, except Extranet
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. Neighborhood allows you to browse, copy. move, and delete files
from secured remote computers via an extranet. while Network

Neighborhood displays all computers on your local network.

- Config Tool: The Aventail Connect Config Tool allows you to create
configuration files that determine how network requests will be routed

and which authentication protocols will_ be enabled. You can add,
remove, or edit configuration files at any time. If necessary. you can
create several configuration files for different users or user groups. If

_ you want to prohibit end users from editing configuration files, do not
_ include the Config Tool in the installation package.

- S5 Ping: S5 Ping allows you to use the ping and traceroute utilities,

two diagnostic tools. The ping utility checks for network connectivity
between two hosts and returns information about the quality of the

connection. The traceroute utility checks for network connectivity by
displaying information about routers between two hosts; it displays
information for each hop. '

- Logging Tool: The Logging Tool is a diagnostic utility that traces
Aventail Connect activity. When running a trace. the Logging Tool dis-
plays errors, warnings, and information as Aventail Connect gener-
ates them. If necessary. the message list can be saved to a tog file
that can be used by Aventail Technical Support lntroubleshooting
technical problems. These traces are also useful when running Aven-
tail Connect for the first time to ensure that network traffic is being
routed appropriately.

- Select Authentication Modules: Aventail Connect lets you select any,
all, or none of the following authentication modules: SSL, CRAM,
CHAP. UNiPW. SOCKS v4, or HTTP Basic (usernameipassword).

- Secure Sockets Layer: Secure Sockets Layer (SSL) is a session-
layer protocol for securing connections in a general. protocol-inde-
pendent fashion.

NOTE: in versions of Aventaii Connect that do not include encryption,
the Secure Sockets Layer {SSL) authentication moduie is not
included. 

v CRAM: The Challenge Response Authentication Method (CRAM)
sends your username and password as clear text between extranet

(SOCKS) servers. but encrypted between servers that support
CRAM. Typically, CRAM subauthenticates within SSL. which pro-
vides both encryption and credential caching options.

NOTE: in versions of Avventaii Connect that do not include encryption,
the CRAM authentication moduie is not included. 
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v CHAP: The Challenge Handshake Authentication Protocol (CHAP)
sends your username and password encrypted across the network to
the destination server.

- UsernamelPassword: The RFC 1928 (lntemet standards docu-

ment) UsemamelPassword (UNPW) authentication protocol sends
your username and password in clear text across the network to the
destination server.

- SOCKS 4 identification: Aventaii Connect includes backward com-

patibility for the SOCKS 4 protocol. SOCKS 4 does not support pass-
word aulhentication, so only your username is sent. unencrypted. to
the SOCKS server along with your connection request.

» HTTP Basic [UsernamelPassworcl): The HTTP Basic authentica-

tion module enables usernameipassword authentication against
HTTP proxies that implement the RFC 2068 HTTP Basic authentica-
tion protocol.

NOTE: Not all versions of Aventail Connect have encryption enabled. 
- Configuration Files: Aventail Connect needs at least one configura-

tion (.cfg) file in order to function properly. The configuration file con-
tains all of the authentication and traffic routing instructions that you
specify. You can include one or more configuration files in the setup
package; however. each configuration file must have a different name.

If you include only one configuration file in a setup package. Aventail
Connect will automatically use that configuration file. If, however, you
include multiple configuration files. Aventail Connect will prompt users
to select a configuration file at startup.

You can include local configuration files. remote configuration files, or a
combination of both. Local configuration files are included in the setup
package and are installed on users‘ machines. If you include remote

configuration files, pointers to those files are included in the package;
the remote configuration files remain in their original location on the net-
work, where they can be shared by multiple users.

If your setup package does not already contain a configuration file, you
can add a configuration file to the package. If your setup package con-
tains one or more configuration files, you can remove or replace any or
all of the existing configurationfiles, or you can leave them, unchanged.
in the package. if you are upgrading from an earlier version of Aventaii

Connect. ‘you may not need a new configuration file.

- License Files: Aventail Connect requires a valid license file in order to

function properly. If your setup package contains a license file, you can
remove or replace the existing license file. or you can leave it.

unchanged, in the package. If your setup package does not contain a
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license file. you can add one to the package. You must use the pack-
aged Aventail license file, aventail . al 3.’.

format than eanier versions ofA ventaii Connect (VPN Client or
AutoSOCKS) did. if you are upgrading from an eartier version
omventait Connect (V2.42 or eanier), you must include a new
Aventaii license tiie.

 I CA UTION: Aventaii Connect 3. 1 and 2. 6 use a different license ( . a 1 f) lite

- Extranet (SEE) Hosts Files: Secure Extranet Explorer (SEE) allows
you to browse remote computers using Extranet Neighborhood. SEE
requires a hosts file that specifies which Windows domains, WINS serv-

ers, and other computers are available in Extranet Neighborhood. The
extranet hosts (SEEHosts) file is contained in the setup package. if you
install SEE, this file is placed in the target directory. If you do not include
a hosts file in the setup package, Ayentail Connect will automatically
create a hosts file on users‘ machines the first time they open Extranet
Neighborhood. (Available only in vtnndows 95, Windows 98, and Win-
dows NT 4.0.)

CREATING, LOADING, AND SAVING PACKAGES

You can create, load, or save custom setup packages through either the Cus-
tomizer Editor or the Customizer Wizard.

..T.° °'°Ft.e 3 '_"e“_‘K._Pa.°“§9e

There are two ways to create a new custom setup package:

- In the Customizer Editor window. select File | New.

-OR- _
o Type the filename of a new package in the first window of the Custom-

izer Wizard and click Next.

.T°.'°a.9'_ .3 .Pa°."§.9“-'.. . ..

There are two ways to load an existing setup package:

- In the Customizer Editor window, select File | Open. and then enter
the filename of the package you want to load

_OR_

- Type the tilename of the package in the first window of the Custornizer
\Nzard and then click Next.

when you load a package. Customizer reads the setup control file to determine

what information the package contains. Customizer uses this information to pop-
ulate the Customizer Editor window. Custornizer also reads the configuration
fiIe(s) into memory; configuration files are stored in memory to facilitate adding
them to and removing them from a package.
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T9 save. ¢hanses.t.9 ?_P.?FK39?_._ _ _

There are two ways to save changes to a setup package:

- After making the desired changes to the package, click Save (or Save
As) on the File menu in the Customizer Editor window

.09-

- Click Save Package in the final window of the Customizer Wizard.

customizes TlPS

The following tips will help you use the Aventail Customizer more efficiently.

- Keep the package size small: You can control the size of your custom
setup packages by selecting components carefully. To keep the pack-
ageas small as possible. include only the options that you need, and

support only the platforms (e.g., Windows 98, Windows NT 4.0, etc.)
that your users work with. You may find that creating two separate.
smaller packages is preferable to creating one larger package. For
example, you might create one package that supports Windows 98 and

Windows NT 4.0 operating systems. and another separate package
that supports Windows 3.1 and Windows 95 operating systems.

- Use descriptive package names: when naming setup packages.
assign descriptive. recognizable names that will help users identify the
setup packages.

- Select components carefully: If you include the Config Toolin the
package. users will be able to view and modify the settings in the Con-
fig Tool. Aventail recommends that, in most cases. you do not include
the Config Tool in your custom setup packege(s}. Excluding options
such as the Config Tool will eliminate users’ ability to modify your set-
tings, and will keep the package size smaller. However, the S5 Ping
and Logging Tool utilities are useful diagnostic tools. and Aventail rec-

ommends including these options in the setup package whenever pos-
sible.

- Install Aventail Connect 2.6 on Windows 95: By default, Vvlndows 95

does not support Wlnsock 2. but you can upgrade it to support Win-
Sock 2 with a Microsoft patch. {The patch, w95ws2 setup . exe, is
available from Microsoft, at

http:l'!www.microsoft.comiwindows95ldownloadslcontents:‘wuad-

' rnintoolsl's__wunetworkingtoolsIW95Sockets2ldefault.asp. How-
ever, this procedure adds an extra step to the installation and setup
process. Unless users need the MuItiProxy feature, which is available

only in Aventail Connect 3.1, Aventail recommends that you install
Aventail Connect 2.6 ratherthan 3.1 on machines running the Windows
95 operating system.

0 Include a hosts file: If you install Secure Extranet Explorer (SEE) with-
out also installing a corresponding hosts file, SEE will automatically cre-
ate a hosts file the first time that users open SEE. -If you want to control

which hosts users can view, Aventail recommends that you include a
hosts file in the custom setup package.
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- Include a license file: Aventail Connect requires a valid license file

(aventa 11 . alf) to function properly. Aventail Connect 3.1i2.6 uses a

different license file than earlier versions of Aventail Connect (VPN Cli-

ent or AutoSOC KS) did. If you are upgrading from an earlier version of

Aventail Connect (V2.42 or earlier), you must use the new Aventail

license file, aventa 11 . alf. Including this license filein the custom

setup package is a simple way to install the license file.

- Test each custom package: Aventail recommends that you thoroughly
test each custom setup package before distribution to users.

CONFIGURING AVENTAIL CONNECT

Create configuration files using the Config Tool or the Configuration wizard. You

can launch either during the Aventail Connect installation or any time you want
to add. modify, or remove a configuration file.

The steps forcrealing a new configuration file-_ar'e:

1. De-firife. the SOCKS servers

2. Define-. the d_e.stination$'.(ne‘t\lvorl<s and hosts)

3. Specify "redirection rules

4. Enter Name Resolution information (optional)

5. Manage authentication modules

6. Enable password protection (optional)

These procedures are described in the text below.

.T.."....'.?F'."".’.'1.‘..'.‘$". 99959 T°°'

The Config Tool opens with the Open Aventail Connect Configuration File
dialog box. After you select a configuration file or enter a new file name. the main

window of the Config Tool appears.

1. Select the Yes, I want to configure Aventail Connect box in the Setup
Complete dialog box (during installation).

-0R.

Right-click the Aventail Connect icon in the taskbar and click Config Tool
(W’IrldOWS 95, Vwndows 98, or Vtfindows NT 4.0 programs menu option), or

double-click the Config Tool icon in the Aventail Connect program group
(Windows 3.1, Windows for Workgroups 3.11. or Windows NT 3.51).

2. If you are creating a new configuration file, enter a name for the configuration
file

-09-

Select the configuration file you want to open.

This displays the main window of the Config Tool.
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Illirtiltj I mil — I". X Ukvi-ml .-1n:l"i.r3i\-'t:r'il.-nil! l_lt‘_]

  
The Config Tool window contains six tabs. The properties defined on each tab

can be edited at any time.

 '- Define" 'e:aranet'(SO£:l$)server(s).
Destinations routed

through t_h&_$0CK_'$._sei_'ver(s}.

$t$;_§E:.in.ee.-n';5ti"‘i1'eiiéioiIé-5ré<inests- at-ej riiiite':ii?'t.¢'- that seems' s.I%ir'.iie'its.)3.

Name Resolution (Optional) $pe_c_;_i_t_’l'es 'hostharhes that will bé._i4ésoI'iiéa"b3i‘tha
local workstation;

Authentication Enables. disables. and sets properties for the authentication

modules. _

Advanced Enablesldisablesextranet (SOCKS) traftic through successive
SOCKS servers, enablestdisables the Application Exclusion}
Inclusion List. secures selected applications, and sets
credential cache timeouts.

 
You can change the width of any of the fields on the tabs by positioning the cur-
sor over the dividing line between the fields on the field bar. When the cursor
changes to a double-headed arrow. click and drag to resize the field.

' Aventail Connect 3.1 allows you to create or modify a configuration file and then
immediately use it. without needing to restart Aventail Connect and any Aventail-
processed applications. When you modify a configuration file, Aventail Connect

can re—read the updated configuration file; all applications being processed by
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Aventail Connect will then immediately begin using the new configuration infor-
mation.

When you make a modified configuration file active, Aventail Connect will save

the current (modified) configuration file. update the registry, and load the

selected configuration file. Aventail Connect will begin using the modified config-

uration file with any subsequent TCP connection requests, andtor any subse-
quent UDP activity.

NOTE: The configuration fite "retresh” feature is supported in Aventait

Connect 3.1 onty. it is not supported in Aventait Connect 2.6. To

activate modified configuration fites in Aventatt Connect‘ 2. 6, you

must first shut down and restart Aventaii Connect and alt appttca-

ttons being processed through Aventetl Connect.

 

I9 !.9.e¢!. e__n199!_ifle.<! s9nfi99_ra*i°n_fi!.e.I°r immediate use

' With the newly modified configuration file open, select Make Active from

the File menu of the Config Toot

-OR-

* From the system tray menu, select Configuration File. and select (or enter

the name of) the configuration file that you want to use. Click OK.

DEFINE AN EXTRANET (SOCKS) SERVER

SOCKS servers are defined on the Servers tab in the Config Tool.

ol — -..__--man-iii. lg
agate. see-“ea
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The name you assign to the server.

H I add ress of the server. 
' The port on which the server is listening.

Aventail Connect 3.1 allows you to set a server fallback timeout for every Aven-
tail ExlraNet Server. If a primary SOCKS server is down, or otherwise unable to

accept connections, Aventail Connect can fall back to a secondary server. You

can set the sewer fallback timeout, in seconds, on a server-by-server basis. if
you do set a server fallback timeout. each connection to a primary server must
be completed within the specified length of time or else the connection will fall
back to the secondary server.

NOTE: Server fallback timeouts are supported in Aventall Connect 3. 1
only. You cannot set a server fallback timeout in Aventail Connect

2. 6; you must let the TCP/lP stack time out.
 

NOTE: Aventall Connect can fall back to only one server. For example,
Aventail Connect could fall back from Server A (primary server)
to Server 3 (secondary server). Aventeil Connect could not, how-
ever, fell back from Server A to Server 8 to Server C.

 

During normal operation. if you configure Aventail Connect to fall back to a sec-

ondary server, connections will be directed to the primary server. If the primary
server does not respond or accept the connection by the end of the fallback tim-

eout period, the connection will be redirected to the secondary server, If the sec-
ondary server accepts the connection. all subsequent connections will

automatically be directed to the secondary server. The secondary server is gen-
erally meant to be used only when the primary server is unable to accept con-
nections. To prevent the secondary server from automatically becoming the
default server for all subsequent connection, Aventail Connect will check the pri-_
mary servers status every ten minutes. if the primary server is back up and able
to accept connection, all subsequent connections will be routed through the pri-
mary server.

CAUTION: Do not enable the server fallback option if you are using plug
gateways.
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1. On the Sewers tab. click Add.... The Define SOCKS Sewer dialog box
appears.

Dtelim:

 

Part Number

se}7eT1~ype'

Fallback

 
“|i’K1;fil'3I'VI.‘l

use
  

.3: 9

Alias Name User-frie ndly alias for extra net (SOCKS) server.
Hostnarne or IP

SOCKS .v4

soc‘KS'v5 "

Detepl 'Vers'ion

afler x secondsL...-
Fall back to secondary server

Fall back to Server“.

Fall back to Host Alias

 
- -u;£i.~«.=§aimii$é:' 'ae:e.....el»_m

SOCKS server porl. Default value is 1080.

so'cI<s-vers'ii:ri' -‘mi.

some vérsién 5.0;

=sér‘ve.r.

Detect SOCKS version
number.

Server fallback timeout period
{in seconds).

SOCKS server alias for
redundant server.

Use DNS records for

redundancy.
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2. In the Alias Name box. type a user-friendly alias for the extranet (SOCKS)
server. Do not leave this box blank.

3. In the Hostname or IP address box, type the actual hostname of the SOCKS
sewer or its IP address.

4. In the Port Number box, type the extranet servers port number. If you do not
enter a value, it defaults to the standard SOCKS port ‘I030.

5. Under "Server Type," select the version of SOCKS supported by the server. If
you are unsure of the version, click Detect Version.

NOTE: Typically you should select SOCKS V5 unless the server can

support only SOCKS V4. 
6. if you want to use a fallback server. select Fall back to secondary server .

after... under "Fallback." Either select Fall back to server and directly specify
an extranet server for redundancy. or select Fall back to host alias. Select or
enter, in seconds, the fallback timeout period. Click OK.

To edit etftranet (__SOCKS) server properties

' Select the extranetserver you want to edit and click Edit.

The Define SOCKS server dialog box appears with the selected server
data filled in. Edit any of the information, and then click OK.

___}:o_r§ri_3_9_ve _a‘r_t_‘_e_g:_tranet (SOQKS) server definition

' Select the extranet server you want to remove and click Remove.

The server is deleted from the list. Corresponding redirection rules will also
be deleted.
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DEFINE A DESTINATION

Destinations are defined on the Destinations tab in the Config Tool.

'w.'}Conli Tol.-I3 ""::I' o toam‘!

  
  

A_it_er;_.or_1_e_ _O_l_' more SOCKS sewers "are defined. add -destinetions_to- be routed
through them.

NOTE: The “(everything else)” destination refers to all network and host

addresses not otherwise defined. You cannot delete or rnodily

“(everything else). ”

Mentail.Qcin'rie<:t'5upestrtsthe..t4.§9.stLiviJsi9erd_,9hat,a!¢t9.r§.i.rt.'£!'e%§1i;natistn_.h9§t:
ne.mes.._.Y9u_,can u§e'.wildc§tds.'.whe.n_.définih9 n'a.rn'e_';!.'destineti.en:-.(h§:§h3am9§).: -
you c:an_n_ot_use_ wildcen;|_s'_wt)en defining numerical destinations. "such as IP' . 3
addresses. or subnet masks-.

Acoeptsble._w'iIdea.'rd_ cha'rajcIer's.'.a'u"fe_ !.‘.'2”.a_r.:.c.I.._“'.'f?,(\v.sii.i.1.§":r'ier: ‘f'.?!?'.-iep'ra._s__étr.i'i.s one c'har- '
ecter, and "*" represents any number of characters)-. For example:

e*tra. in . aventail . com matches ex,t'1:a.. in _. aventiai 1 . com
e?,tra.-in .a_.Ventail . com matches extra. in .ave'ntaj.l .com '

e?ra . in . aventa-il . com does NOT match extra . in . aventail . com-

You -can use oombinetion of “'7” and "*" characters between each set of peri-
ods. H9w_ev9r._ each s'°a<_=t.ion must. contain at !.east.or!e. Tl°".°W_iIdt_=8|'d character.
For example. the following destination names would be allowed:

e.-?t?a. in.aventai1.com

*xtr?. in .aventai'L . com

e???a.in.ave*.com

e* .3'.n. *tai'l.. corn

The following destination names, however, would not be allowed:
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extra.*.aventail.com

*.*.aventail.com
extra.in.*.com

CAUTION: You cannot use a wiidcend character, or a series of wiidcard characters,

to represent multiple secflons. Any wiidcard character in a section can

represent characters wr'thin that section only For example:
Q

:9‘ .in.avenr.'a.1'.I. com matches extra . in.aventa_il. com

e* . aventail . com does NOTrnatch extra. in. aventail . com

T° “=!!+“...‘!..E. 9:‘=5“"a"i°"

  ‘
c¢m_aQ$9,t§.;9r.:I,B;§Qs;:9§§5.ran9§§;a ,§§_t,.La_L=~;r.L,'z.Fc;‘.»:;:s4_-'.aI=j<'I.s4t=
no_'_ne of;th_e_.iF_’ .t'rafflc'to_ these defined destin'atio'n$:

1. On the Destinations tab, click Add....

The Define Destination dialog box appears.
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a1-r‘ 

Alias Name User—triendIy alias for destination network or host

Singte Host : A specific destination computer

' Actual name of destination network or
host

IP Address (options!) Full numeric IP address

One or more computers in a network

Domain Name Domain of thenetwork

éuubnet-(optional) it 'ip’aaa}e'ss tiatnitimgst address "

Address Range Beginning and ending IF’ addresses
(optional) From Starting IP address

To Ending IP address

 
CA UTION: The IP Address, Subnet, and Address Range fietds

' are an optional. However, in order to apply redirection
rules when connecting by IP address, you must enter iP
address and subnet information.

2. In the Alias Name box, type a user-friendly alias for the destination network
or host.

3. Select either the Single Host or Network option:

' Under "Single host,“ type the actual name of the host system andfor its
full, numeric IP address. If you do not know the host's IP address, click
Lookup to search for it.

-09-

- Under "Network," type the domain of the network and then, if applica-
ble, select either Address Range or Subnet.

— . , . _r..=e.»..'-_

Enter a starting and ending IP address. All addresses between the

two will be included as part of the destination. For example, a
stoning IP address of192.1.1.0 and an ending IP address of
192.1.1.255 would include all hosts ofthe 192.1.1.x subnet.

Enter an IP address and a netmask address. This is another way
to specify a group of destinations. For example, an IP address of
192.1.1.U and a net mask of 255.255.2550 defines the same
address range as shown above.
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To edit a destination

' Select the destination you want to edit and click Ed it....

The Define Destination dialog box appears with the seiected destination

data filled in. Edit the data as necessary.

. T_°_ "9"?_‘__’Y‘_’ §'__‘_i°§*__i_I?:"'_*__i_!?'E.‘ _. ..

' Select the destination you want to remove and click Remove.

The destination is deieted from the Iist. The corresponding redirection
rules wilt also be deleted.

ENTER REDIRECTION RULES

Once servers and destinaticns are defined,. you. can specify how youwant. Avon.-T _ _
tail Connect to redirect (or deny) access to various hosts and services such as e-
mail, FTP, and HTTP.

Redirection rules are specified on the Redirection Rules tab in the Config Tool.

I .' nriliii

Destination Destinations defined on the Destinations tab

Type? is: lnteniét-trsfflt:

Proxy Redirection Specify how to redirect traffic
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You can change the width of any of the three fields by moving the cursor to the

dividing tine between the fields on the field bar. When the cursor changes to a

double-headed arrow. click and drag to resize the field.

T9.".‘.‘.'_'.!__3 "?_‘_“."‘_3_‘_’.t.i..°.'.‘_._'.‘-."‘?_ .

As you add destinations, use the arrow buttons to prioritize them. List the most

specific rules first and the general rules last.

NOTE: Aventaii Connect scans the fist from the top down and uses the

first matching ruie it finds, so it is important to iist the most spe-
cific ruies first.

1. On the Redirection Rules tab, click Add.

The Define Redirection Ruie dialog box appears.
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Proxy
Redirection
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' Host or server destination for rriessaoe traffic.

Use a" P°'='~*
Beginning ofport Appty thTe'.'de_tiried'. 'n_iIe-to3_th.i§' tt,Irt'g'e"_o.f go'i.t§..
range   
End of 'r.iont'rang'e

TCP and UDP Apply ma defined rule to both TCP and uop.
traffic. -

Apply the "defined rule to TOP traffic only.

Apply the defined rule to. UDFF. traftio only.

TOP only .

UDP only .

' Specifynhow to redirect traffic.

Redirect via" — aj1i_:"tra,_t_'_f_l\c_:;t:t"irfo'LIgiI the-.e:ktré'net server.
selected H16‘ list.

 

 

 
   Do not redirect R.ou.te.ira_ific.cIire_i:iIsi.ici_'xiié_.$hegifies1id_’§si'ih'ation

without being _redirected.'through SHOCKS".

Deny '-§e'Moe ' D.e.i1¥ ..access.'1.9.th,6 :§iti.e.cifad .d'a.§t.irié3i9n.— The.
netw"orlt_ eon_n_et;t_lo_n- :_b|oclt6d locally‘ instead of
at the server level.

2. Select a destination from the Destination iist.

3. Under “Service.” select the Use ail ports box toapply the rule to alt services.

Otherwise, select a range of ports. To select a single port. enter that port num-

ber in both the Beginning of port range and End of port range boxes.

4. Under "Proxy Redirection," select one of three redirection options.

...T9..?_‘?!?FP.-.'°.°_‘FE":9'Ei°" “"9

CAUTION: it you select Deny Service and the user has edit control

of the configuration fiie, the option can be circumvented

by quitting Aventaii Connect or by changing the option in

the dialog box.

' Select the redirection rule you want to edit and click Edit....

The Define Redirection Rule dialog box appears with the selected data

filled in. Edit any of the information.
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7.9 "°"_'_'°‘!’.‘f..3.._.T“-?_‘..‘i'T!*!+‘?i_F_’.F‘ .'!!_'.‘E‘-T. _

' Select the redirection rule you want to remove and click Remove.

The redirection rule is deleted from the dialog box.

DEFINE NAME RESOLU110N

Name Resolution instnictsaventail §_3onn_e'._c.t tq.rasqlvehostnanlae.JQc§!ly'with&: .'
out needing to .v.e_nt.ure.on tome l_ntei_rneti.-,Iili$-.9pfion.a|' fe,.€.l.t..ure_'9f_1_’er xou an0tfi6f'
level of control over how--Aventail-Cohnéct"perfonnsI_narne re'soljution;;»' -
The local workstation resolver is the name resolution component of the local
TCPIIP stack. This feature acts as a shortcut; hostnames matching the strings
defined in the Name Resolution dialog box are passed to thelocal resolver for
name resolution instead of being proxied through the SOCKS v5 server.

For example, if aventail.com is added to the Defined Strings list. then a work-
station attempting to connect to www.aventail.com would perform hostname
resolution using the local TCPHP stack.

Name Resolution is specified on the Name Resolution lab in the Config Tool.
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Specify a domain New domain name
- recognized by the

workstation resolver

Known Domains List of domain names that can be resolvediocalty

iaéaarea ‘unqualified i ”Pass'through ;;.i'q.;;i:'iné'ai'n}¢%;;i§.;E.i;;iE3'in;‘i¢;Eas‘eégBiG;{’ "
names via

Allow Reverse DN5 Enable Reverse DNS (converts IP addresses into hostnames)for destination

matching
....._. . _j.__.._.._._.:._j ___.__...._gT_?_*.__.% _____I 

 
To.as19_at!9.#=a'_¢i¢2n1.air2nw T T- -| I

' On the Name Resolution tab. type the new name in the Specify a domain
box and click Add.... '

- If necessary, select Allow Reverse DNS for destination matching.

The new name is moved into the Known Domains box. it is new active.

CAUTiON: The reverse DNS process can create unexpected
_ deiays, causing Aventaii Connect to behave unpredict- ' abiy. Aventaii recommends that you do not enabie this

option uniess you speciflcaiiy require the Reverse DNS
i‘unctionaii'{y. -

To remove a local domain name

° Select the domain name you want to remove from the Known Domains box
and click Rem ove.

The domain name is removed from the list.

MANAGE AUTHENTICATION MODULES

SOCKS v5 servers often require user authentication before allowing access.
Aventail Connect authentication modules display dialog boxes that prompt users
to enter username and password information as well as other authentication cre-
dentials.

NOTE: Not aii versions of Aventaii Connect have encryption enabled. 
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The current Aventai! Connect authentication modules are SOCKS v4 Identifica-
tion. UsernameiPassword_ Challenge Handshake Authentication Protocol
{CHAP). Challenge Response Authentication Method (CRAM). Secure Sockets
Layer (SSL), and HTTP Basic (usernamelpassword). Each of these authentica-
tion modules supports an Aventail Connect feature known as credential caching.
Credential caching retains your authentication credentials once the extranet
server has accepted them. Using credential caching, you can enter your creden-
tials for an extranet server once per Aventail Connect session. rather than once
for each individual connection (a tedious task for applications such as WWW
browsers).

Aventail Connect can cache authentication credentials in memory, based on the
option you select in the Authentication dialog box. Memory caching stores the
credentials for the current session only. when you restart Aventail Connect or
Windows. the memory cache is flushed and you must reenter your credentials
as prompted. -

SEE ALSO: For additionai information on credentiai caching, see
“Credential Cache Timeouts" in the “Advanced Tab
Options" section of this Administrator’s Guide.

Authentication modules are managed and configured through the Authentica-
tion tab in the Config Tool.

CL1I)Iiq Tu-_-E C.a-._;m-._-nadir‘-.r&.t-..-i-.i..it.as

 
  

tfliNLil..t.Aulhsr:icatiun um»

53ii:
Chalh'ruge-Hecpomshuinariicafiont-tsit

5-5i. vlflldoumlit: was-Iglhfi

Clultmti norm-ord. using cash: manger
1.4!_1'3?5D.;.g'u—..m vi:-in
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Module Name The name at the authentication module on disk. <t~iu11 Ruth)»
indicates that no authentication module will be used.

Description The description of the authentication method.

Indicator Check this option to display network traffic passing through a selected
authenticationiencryption module. See the example below (for
Windows 95. Windows 98, and Windows NT 4.0).

Application NETSCAPEEXE
Usernami-.-.fPas sword Connection Io Aventail 

Each authentication module includes its own module-specific configuration. To
view or edit a module's configuration. select the module from the list on the
Authentication tab and then click Setup. An options dialog box for the specific
module will appear.

Enable and disable authentication modules with the DisableiEnabIe button. By
default, the modules are all enabled. The green button next to the module name
indicates an active module. This is the default state of all the modules. The

_ green button changes to red when you disable the module.

To configure the SOCKS 4 identification module

Aventail Connect includes backward compatibility for the SOCKS 4 protocol.
SOCKS 4 does not support password authentication. so only your username is
sent unencrypted to the extranet (SOCKS) server along with your connection
request.

Your username is determined by entries in the SOCKS 4 Identification Module
Configuration dialog box.

1. On the Authentication tab in the Config Tool, click s4auth (SOCKS v4 identi-
fication) and click Setup.

The SOCKS 4 Identification Options dialog box appears.

' Aveitfaii‘ Connecr3.1/2.6 Aanimrsrraiors Guide - 4a
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  Use Windows

Login

   
 

Use Netware

Login
Identify users by their Novell Netware Login names.

 

 
 

 
 

 
 

 
 

Prompt user
for name Identify users by the names they enter for this specific purpose.

 
 

 
 
 

Allow Memory Stores credentials in memory for this session
Caching . only. Cache is flushed upon restart;

I credentials must be reenterecl as prompted.

rmlow Disk Caching This option is currently unavailable. (Stores
L credentials on disk for future sessions.)

2. when you select the Prompt user for name option, you must also select the
desired caching option. (Currently only Memory Caching is available.)

3. After making appropriate selections, click OK.

The dialog box closes and the Config Tool reappears.

_'l'_o configure the _L_i_se_l_'nameiPass__word authentication rn9du_Ie__

Aventail Connect supports the RFC 1928 (Internet standards document) user-
name and password authentication protocol. This authentication method sends
your username and password in cieartext across the network to the destination
server. The Usernamel'Password authentication module dialog box contains
only credential caching options.

1. -On the Authentication tab in the Config Tool, select unpw and click Setup.
The UsemameiPasswond Options dialog box appears.
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  r: . . . . , L.-J "'

Stores credentials in memory for this session only. Cache is
flushed upon restart; credentials must be ieentered as prompted.

 
 

 Aliow me-mfloiv
caching

 Allow Disk Caching This option is currently unavailable. (Stores encrypted
credentials on disk for future sessions.)

 

  

2. The selection defaults to Allow Memory Caching. Click OK.

The dialog box closes and the Config Tool reappears.

.T9..99rIfia9.rs__ihs _.°_H§P_ .*i'.*.!.*?i.'°"‘..!“.+“i_.‘!i°.'.‘ n19<ls_|_2__. ..

Aventail Connect supports the Challenge Handshake Authentication Protocol
(CHAP). This authentication method sends your username and password
encrypted across the l1EtWO|'k to the destination server. The CHAP authentica-
tion module dialog box contains only credential caching options.

1. On the Authentication tab in the Corifig Tool. select chap and click Setup.
The CHAP Options dialog box appears.

 
 

 Allow memory Stores credentials in memory for this session only. Cache is
caching f flushed upon restart; credentials must be reentered as prompted.

  
  
 Allow drsk caching This option is currently unavailable. (Stores encrypted

: credentials on disk for future sessions.)._____.-___._.:..Lj._.___.___.__,___.
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2. The selection defaults to Allow Memory Caching. Click OK.

The dialog box closes and the Config Tool reappears.

To__c_onfigure_._t_he CRAM authentication module

Aventail Connect supports the Challenge Response Authentication Method
(CRAMJ. This authentication method sends your username and passcode as
cieartext between extranet (SOCKS) servers. but encrypted between servers
that support CRAM. Typically, CRAM subauthenticates within SSL, which pro-
vides both encryption and credential caching options.

1:

it-.ti5uP,ut'ng cache eianaga
SGCXS --1 Idlntlicuflnn
_ _‘,i=_-: :_":'- H: " "' " 1' C .:':'.III "1. -I

5SLv3.Dli:|imas 
You do not need to configure the CRAM authentication module. You can enable!
disable it, by clicking on the Disablelfinable button. The button at the left of the
module name will change from green to red. accordingly.

Ave.ntai.I .C_onn..e_et s.Upn9n.s_ Sia._<.=.i.ar_e.-.S.<'=i<.=_.i.<i'a..ts': _l;aye.'_t..’('$Slr.}).,_i.i'..’o‘_;95...: session-Iay.e.r'~
protocol for securing‘-connections in a "general,-_ ‘protocol-.indep_endent'fashion:

NOTE: Currently. 58!. is a TCP-only enhancement. when using SSL
with User Datagram Protocol (UDP) appiications, bulk data is
passed without encryption.

Normally SSL servers are required to have an RSA key p_ai_r_ and a certificate.-
Aventail uses an. R.-SA 8..|90i’.iti1m _t.-:i-..f-‘.F.*.#?».'a.1..6_.a'coiP?°9faPhJi?..53t$!§rn.=. 3 p.ri_-_?a.t_e' isey.._._. .
(which, as the narn‘e'sugges_ts. is kept absolutely private and never shared) and
a public key (which is widely published);
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NOTE: in versions of Aventail Connect that do not include encryption.
SSL is not available. -

However, as the client. you normally must then establish some kind of relation-
ship between your RSA public key and the identity of the server, so that some-
body else cannot create their own RSA key information and use it to

impersonate your server. Certificates establish this relationship. A certificate is
essentially an electronic "statement" that verifies that a certain RSA public key is '
associated with a particular name.

Certificates are issued by a Certification Authority (CA). and are linked together
to form a construct called a certificate chain of authoniles, each one having a
previous entity vouching for its identity. In practice. chains generally include two
certificates: one confirming the identity of the server. and the other--a "root" cer-
tificate-containing the identity and public key of the CA.

Certificates contain special integrity checks and electronic signatures that verify
that the certificate is genuine. was issued by a certification authority, and was not
tampered with. Anybody can issue a certificate that says anything; the client
must know who issued the certificate, and have some trust relationship in order
to believe that it is in fact true. The client has a list of trusted CA5. A set of certif-
icate chains can be structured as a tree, with new certificates stemming from old
ones. A base CA is sometimes called the "root" or "trusted root" of this tree.

it is becoming common practice for both clients and servers to exchange certifi-
cate information. However, in Aventail Connect the client- side of this exchange
is transparent. The client only needs to deal with the information from the server
certificate and this is done through the SSL module.

The SSL module dialog box contains an initial set of options regarding the view-
ing ol certificates.

1. On the Authentication tab in the Config Tool, select sslclnt (SSL \i3.0) and
click Setup.

The SSL Options dialog box appears.
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The certificate is valid.

Upon successful connection, display the server
certificate if it has not been displayed during the
current session.

  
  

Upon Successful Connection

wew when the server
certificate is new.

 
  

 
 

  
 
 

 '65 list ‘show ring iii; ' "né§.?$} u}§';3i5§L §}§u'aa'?e}R}E}"£éHifié££é7
certificate.

if a server certificate is suspect The certificate may not be valid.

Always show me suspect Each time Aventail Connect suspects a certificate
certificates. may not be valid, show the certificate.

Once a suspect certificate has been accepted by
suspect certificate once. the user. do not display it again.

Show me the certificate. Reject the connection, but display the suspect
but reject the connection. certificate.

2. Select an action that Aventail Connect must take once it accepts the validity of
the server certificate. (Under normal circumstances, the server wilt provide
Aventail Connect with a certificate to match one of Aventail Con nect's trusted
roots, if any exist):

- View when the server certificate is new: Aventail Connect displays
the certificate the first time it is seen. The certificate will not appear on
subsequent connections to the same extranet server.

- Do not show me the server certificate: Aventail Connect will never
display a valid certificate.

3. Select an action that Aventail Connect must take if it receives a server certifi-
cate that is suspect:

 

 
 

 
 

 SHOW me the same

  

- Always show me suspect certificates: Aventail Connect will display
suspect certificates each time they are received. The Certificate dialog
box will appear for each new connection to the server(s) sending a sus-
pect certificate. (This option allows you to continue the connection
despite the fact that the certificate is questionable.) The SSL module
authenticates the server’s certificate based on the following questions:

- Is the certificate valid? _

- Did a trusted certificate authority (CA) issue the certificate?

- Is the name established by the certificate the same as the name of
the server for this connection?

if a certificate does not pass all three tests, it is considered a suspect certifi-
cate.

- Show me the same certificate once: Aventail Connect will display a
suspect certificate the first time that it is received. if you choose to
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maintain the connection, the questionable certificate will not be dis-
played again during the current session.

- Show me the certificate, but reject the connection: Aventail Con-
nect will reject a connection it the certificate is suspect. It will display the
certificate to allow you to view it.

4. cIi<=I< Advanced in the .di.a|99. béx to. show. the éocentaizle F.-‘iphef ca c'ryptb- a
graphic algorithm used to encrypt the data stream} options.
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Acceptable Ciphers

Allow RC4 Offer the RC4 cipher to the server.

Allow DES Offer the DES cipher to the server.

Allow NULL Encryption ' Do not encrypt using SSL. SSL will be used to
- authenticate only.

Allow Diflie-Hellman Do not authenticate the server: only do encryption.
Anonymous - .

Enable Compression Use SSL compression to improve performance when
slower connections are detected.

 
 

 
    

Server Validation

   Trusted Roots Use a trusted roots file to validate trusted certificate
chain roots.

l\lClTE' The trusted roots filo MUST be placed in the same directory as
the Aventail Connect configuration me.

Configure trusted roots

Use an LDAP server to validate trusted certificates.

  

 
 
 

 

 
  

 

Configure Configure LDAP

Maximum Chain Length _ Specify the maximum allowable certificate-chain length.

Client Certificate Select a client certificate file.  

  NO T6: The client certificate MUS_T be placed in the same directorythat A ventail Connect was ir.-srafled to.

Select the specific tile

D_ur.ino..t.h_e_initial S$L.¢.>onne9ti9o. the client. a.nd:,th_e semer__ne9o3iate..lehi9h_
¢iphe;..to._use', Ch.e.c.lsi.no.a pa.r1i'cuIar_¢iph.erintlJ.e..c1i.al_99..h<12s..¢loes.not-niean-=.._
that it wiIl..be..use9l.... ,|f!5..t.6.3_‘.-Tl...e_ach _cheo|sed..¢:ip.h.a.r.,i$. to_.the.,seryer...t;ut. _ ..
the s.er_v§r.-..r!.e.tei.r.rlii_n.e§_ r.:¢hi,c':_h_'s=ipher‘:_t9; requires 2:‘ cipher that .
is: noteelected in this"dia|og.-box.-the authentication-isgilI..teiiI_

Any or all of the acceptable cipher options can be selected:

0 Allow RC4: Aventail Connect encrypts the information using the RC4
cipher. '

0 Allow DES: Av-entail Connect encrypts the information using the DES
cipher.

- Allow NULL Encryption: Aventail Connect allows the server to select
no encryption. Message integrity is still assured, but the data will be
sent in cleartexl.

- Allow Diffie-Hellman Anonymous: Aventail Connect will be able to
communicate with the extranet (SOCKS) server without requiring a
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server certificate. The client and server will not exchange certificates.
so there will be no authentication. The encryption will still be negotiated,
and the data stream will still be encrypted (unless NULL encryption“ is
chosen by the server).

- Enable Compression: To speed the encryption process and enhance
_ overall performance. Aventail Connect will automatically compress
encryption when a narrow bandwidth andior slow modern are detected.

5. If necessary. add (or delete) a trusted roots (* . rot) file andior an LDAP
server definition.

To add or remove a tr_usted root

a. in the SSL Options-—-Advanced dialog box; under “Server Validation."
select Use local trusted roots file. and then click Configure.

The Trusted Roots dialog box will appear. -

b. Enter the name of the trusted roots file. or click Browse to search for the
file, and then click OK. -

CAUTION: The trusted root fiie must be in the same directory as
the Av/entail Connect configuration tile.

c nf' L

a. In the SSL Options—Advanoed dialog box. under “Server Validation."
select Use LDAP, and then click Configure.

The LDAP Configuration dialog box appears.
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 ._ L__ ____

Enter the login
server.

Search Base  

Certificate Attribute

Alias Matching

SSL PropertyrLDAP Alias

 
  

Add Alias

Delete Alias '

Certificate template file:
 

template.

‘Enter the LDA; server ltostl-nlarune.

Enter the password for the LDAP server.

Search Criteria '

Enter the DN to use as the search base.

Search available DNs to use as search
base.

Enterthe certificate attribute.

l-\_la_r1_1;‘ofSSL—pFo'perty and corresponding LDAP alias.

Add an LDAP aliastSSL property. -

Modify Alias Modify an LDAP alias.

Delete an LDAP a|ias!SSL property.

(Optional) Enter name of certificate file to use as

Search available certificate files.

 

 
 

 
 

 

DN (distinguished name) for the LDAP

 

  

  
 

   
 

 

  
b. Under "LDAP Server,” enter the LDAP server name. and the DN and

password that you want to log in under.

Under “Search Criteria,” enter or select the DN to use as the search

base, and enter the certificate attribute. (In most cases, the certificate
attribute will be "usercertificate.”)

as search criteria.
Under "Alias Matching." select the SSL properties that you want to use

If necessary. you can modify any of the LDAP aliases to map to the SSL
properties. To modify an LDAP alias.
Alias Matching dialog box. enter the

click Modify Alias. In the LDAP

LDAP Attribute that will map to the
SSL Distinguished Name Component. You can also Add or Remove an

S8]. propertyILDAP alias in the LDAP Alias Matching -dialog box.
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in the Certificate template file: box, you can specify a certificate file to
use as a template. If you specify a certificate template file. Aventail Con-
nect will automatically populate the “SSL PropertyiLDAP Alias“ box with
the attributes used in the specified certificate template file.

e. Click OK.

6. if Aventail Connect sends a client certificate to the server during the initial
authentication exchange. it sends the certificate identified in the Client Certif-
icate window. To load the client certificate, press Browse and then select the

client certificate (* . Ce 1:) from the Aventail Connect directory. Only the file-
name of the certificate file loads via the Browse button, and not the path-
name.

 _ CAUTION: The ciient certiticate fife must be placed in the Aventaii
Connect directory.

When Aventail Connect receives a certificate from a server. it looks at the root

of the certificate chain and matches it against the Aventail Connect list of
trusted roots.

You can specify the maximum number of certificates in a certificate chain. The

default maximum length is two certificates. in most instances, Aventail recom-

mends allowing no more than two certificates to form a chain, although you
can specify up to ten. The longer the certificate chain. the less secure the
chain is. ' '

than two certificates in a certificate chain. Aiiowing more
CAUTION: in most instances, Aventaii recommends aiiowing no more

 - than two certificates can compromise security.
?_ After making appropriate selections, click OK.

Pl-(‘CS #12 CERTIFICATES FOR USER Autl-rEM1'lcAnorv
Aventail Connect supports PKCS #12-forrnatted X509. .client- certificates for SL.
authentication. PKCS #12—forrnatted certificates are stored in a portable format
for easy exchange between applications. You can generate client certificates by
enrolling with a public-Key infrastructure (PKI), such as Verisign Onsite. You can
then use your Web browser to export the client-certificate to a PKCS #12 file in
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the Aventail program directory. When users connect to an Aventail Extrahlet
Server for the first time. they will be prompted to select a certificate.

To export a PKCS #12-formatted X.509 certificate

1. Using a Web browser and a CA, such as Verisign Onsite. obtain a client cer-
tificate.

2. Export the certificate to a file in the Aventail program directory. You can use
any fiiename. This step varies from browser to browser.

tgjicrosoft lnterngt Explore; 4.01

a. Select View|Intemet 0ptions...|Content|Certificates|PersonaI....

b. Select the certificate that you want to export, and click Export...

c. Specify-a password to protect the certificate. '

ct. Save the file to the Aventail Connect program directory.

export PKCS #12 certificates properly. This problem was cor-cg CAUTION: On vwnaows NT, Microsoft interrret Expiorer 4.01 does not
rected in Microsofi tnternet Explorer 5.0.

‘c o o Intern x lo 5.

Select Toolsllntemet Options...lconlenticertlficaiaes|PersonaI....

Select the certificate that you want to export, and click Export...

in the Certificate Export Wizard, click Export the Private Key.

Specify a password to protect the certificate.

Select the PKCS #12 format. _

Select Include all certificates in the certificate path if possible.

9. Save the file to the Aventail Connect program directory.

Netgcag Navigator 4.5

a. Click the Lock icon in the lower-left corner of the main Netscape Naviga-
tor window.

b Select Certificate|Yours.

c. Select the certitficate that you want to export. and click Export.

d Specify a password to protect the certificate.

-""F”.°-.0579’

a. Save the file to the Aventail Connect program directory.

3. Use an Aventail Connect configuration file and server setup that forces the
user to authenticate using client certificates. Configure the Aventait ExtraNet
Server.

4. Initiate a connection that forces the user to authenticate. You will be prompted
for a certificate file. Select the certificate that you just exported. and then click
OK.
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PKCS #11 SMART Cnnos FOR USER AUTHENTICATION

Aventail Connect can use client certificates that are stored on PKCS #11-com-

patible smart cards for SSL authentication. Currently, Aventail Connect supports
the DataKey and Spyrus Rosetta smart cards.

Aventaii Connect will be prompted for a file (or smart card) containing certificate
information only when the SOCKS server requests client authentication using a
certificate. If a SOCKS server requests client authentication with a certificate,
and no certificate is already specified for that host. the user will be prompted to
select a certificate. You can configure passwords or PlNs to be cached to mem-

ory, or you can specify that users enter passwords or PlNs each time they use a
smart card to authenticate.

T9_.°9Flfi.9E’.F°.".!5.‘.3.$_ #11 .5T9937E?IF'J!§‘?"_§}!"‘°"“°°"i°"

1. Use a smart card with an X509 certificate stored on it.

2. install the appropriate smart card software on the user's computer.

3. Include the public certificates of the CA (and any intermediary CA5) for the cli-
ent certificate in the trusted roots file that Aventail Connect is configured touse.

4. Configure Aventail Connect to redirect to an Aventail ExtraNet Server that
requires client certificates.

5. initiate a connection.

6. When prompted, specify whether you want to authenticate with a client certifi-

cate that is stored in a file, a client certificate that is stored on a smart card. or
no client certificate at alt.

7. Aventail Connect will prompt you for the path of the dynamic link library (DLL)
for the smart card's PKCS #11 module. This is the same DLL that is used with
Netscape Navigator. Enter the DLL pathhame and click OK.

8. Aventaii Connect will display a list of all detected smart cards on the system. If
you have not yet inserted your smart card into the appropriate reader, insert it
and click Refresh List.

9. Select your smart card and click OK.

‘l0.lf the smart card is protected with a PIN, you will be prompted to enter it.

‘l1.Select the private key you want to use, and click OK.

NOTE: Once you specify a smart card token or client certificate to be

used with a server, this setting wiii be remembered indefinitely To
reset the setting, select Credentials from the Aventaii Connect

system tray menu, select (bighiight) the credentiais, and ciicir
Delete. Your PIN will not be remembered.
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ADVANCED TAB OPTIONS

The Advanced tab in the Config Tool contains three advanced options. In the
Advanced tab. you can allow SOCKS tunneling through successive extranet
(SOCKS) servers, secure selected applications, and set credentiat cache time-
outs.

 
ALLOW SOCKS TUNNELING THROUGH SUccEssIvE EXTRANET SERvERs

Once servers and destinations are defined. you can direct SOCKS traffic
through successive extranet (SOCKS) servers.

On the Advanced tab in the Config Tool. select the Enable redirection... box to
allow credential infomtation to forward to successive extranet servers.

SECURE SELECTED APPL|CA‘l'lONS

This option allows you to:

- secure all applications except those listed,

- secure only the applications that are listed,

- or secure all applications, enabling neither exclusion nor inclusion.

NOTE: You can exclude and indude only 32-bit applications. You cannot
. exclude and include 16-bit applications.

 

You can exclude or include specified applications in the Exclusionilnclusion List.

With the Exclusionilnclusion List. you can secure all applications except those
on the list. or you can secure only those applications on the list. The default set-
ting is to secure (hook) all network applications.
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Excluding Applications

You r;ar1,e$ccIude_ s_pecifi<_: applic.:a..t.ions.th_rou9h the F-._x<=._i..t.z..e'e_is..=‘.r_v,'.|._rI.«:In.:siotr_r_.'
you enabIe_tl19.;"Sac.uIa._aIl appIi.cafiqn§'9xcant listed: option. Ay,en.tai|. Connect -
wiunot pnoxy any’ appiications that are on the _Exclusion!IncIusion List;

To exclude an application

1. Under "Applications to Secure,” select Secure all applications except listed
and click Modify List.

2. Click Add....
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The Specify Application dialog box appears.

!,n..g1.,- .-a'.:., . p'fb.'.9' .-~.-...-..a..:s. yaw--q..¢n.n.n-L.u.¢....-um. pm -a..«..Anu.i.»o.-.-4;.~...n.o«u._.- .»\m—..-ra'.|Im.r‘nI-q#nI>'uI-vhfl-¢uu .'.¢nn-t-.u..n.a.¢.a.a......;......~.n.n-i..¢u.

 
 

Déflchk . ..
Enetscape.exe
LflNpWrap.exe

nsmtilyeue

   
3.. Highlight the app|ication(s) to add to the Exclusionilnclusion List, and then

click Open.

The Specify Application dialog box disappears and the applications are now

in the Edit List dialog box. _

4. In the Edit List dialog box. select All occurrences or Only this occurrence.

NOTE: You may have more than one path (instance) ofa specified file-
name {e.g., ftp . exe). You can choose to exclude one specified
application, with a fuiiy quaiiiied pathneme (e.gr., C: \win—

dows\Sys32'\ ftp . exe), or ail instances of a specified fiiename
(e.g., aii instances of ftp. exe).

 

- Only this occurrence: Selecting this option excludes only the speci-
fied application.

- All occurrences: Selecting this option excludes all applications with
the specified filename.

T‘.’.‘-!"“_’9 3_l?P".FF.a.".9’?_.€EEE'.!‘.5fi9'?__ . ..

1. Under “Applications to secure.” select Secure all applications except listed,
and then click Modify List.

The Edit List dialog box appears.

2." Highlight the application you want to remove from the Exclusionilnclusion List,
and then click Remove.

The application is removed from the Exclusionilnclusion List.
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including Applications

Yo.u_can inclu_de_.specifi_r_: applications through the E_xo_lusior_1i_ln_c;lg_i_siori I_.ist_. when
you enable the_f'Se_cure__only applications iis_ted“ _option_,_ A\_i_enta_i_l Connect will
hook only those applications that are on the Exclusionilnclusion List.

To include an application

1. Under "Applications to secure.” select Secure. only applicationsflisted. arid: '
then click'Mo.clify List."-

The- Edit List dialog box_ appears.-

2.' Click Add

The-Specify Application dialog box appears.

3. ‘I-iigl'i_li_g_11t_ tl_1__e_- application(s) to add tothe Exclusionilnciusion. List, and then
click Open;

T_h..e._ Specifimnni_ig:'aition'_giaiog box disappearsand the applications_are.now"'.
in the Edit List dialog box.

4. In the Edit List dialog "select All‘ occun-'e'i_i‘i.e'.-s ‘or oniy this 'd:&‘cunance.-

' NOTE: You may have more than one instance ofa specified application
(e. g., ftp. exe). You can choose to inciude one specified appli-
cation, with a fuiiy quaiified patnnarne (e.g__ g: \Win—

dows \ Sys 3 2 \ ftp. exe), or at! instances of a specified
appiication (e. g., at! instances of ftp . exe).

 

- Only this occurrence: Selecting this option excludes only the speci-
fied application.

- All occurrences: Selecting this option excludes all applications with
the specified filename.

__fl_'_o __t.indo application inciusio_n___

1. Under “Applications to secure,” select Secure only applications listed. and
then click Modify List.

The Edit List dialog box appears.

2. Highlight the application you want to remove from the Exclusionilnclusion List,-
and then click Remove.

The application is removed from the Exclusionilnclusion List.

Securing ait Applications

You can secure all applications, enabling neither exclusion nor inclusion. When

you secure all applications, Aventail Connect ignores- any applications on the
Exclusionilnclusion List.
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To secure al__l applications _ _

' On the Advanced tab. under "Applications to Secure," select Secure all
applications.

NOTE: Au/entail Connect secures all applications by default. Unless you
need to exclude or include specific applications, Averitaii recom-

mends that you use the default Secure all applications setting.

 

net information Server (HS) and Microsofl‘ Peer Web Server)
include inetinfo.exe, which conilicts with Aventaii Connect

3.1. To eli'minate this conflict, exclude inetinfoexe through
the Application Exclusion/inclusion List in the Config Tool.

 - CAUTION: Microsoft lnternet server products (including Microsoft inter-

CREDENTIAL CACHE TIMEOUTS

With the credential cache timeout feature, you can control when credentials
expire (time out). If a user has not made a connection to the extranet (SOCKS)
server for a certain length of time (determined by the administrator). then the
credentials will automatically be deleted from the credential cache. If a credential

times out. the user must reauthenlicate by entering the proper credentials before
regaining access to the extranet. This feature can help to prevent unauthorized
users from gaining access to secured areas.

 
There are three credential cache timeout options.

- Never time out cached credentials: Credentials never time out.
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- Time out credentials from time first entered: Credentials time out x

minutes after the user first entered the credentials (where "x" is the
number of minutes you enter in the Min. box).

- Time out credentials from time last used: Credentials time out it min-

utes afler the user last connected through the extranet server (where
"id is the number of minutes you enter in the Min. box).

regular intervats, the mail-checking frequency must be
longer than the credential cache timeout. For example, if
your mail program is configured to check for mail every
ten minutes, you shoutd set the credential cache to less
than ten minutes.

 ' CA UTION: it your mail program is configured to check for e-mail at

ENABLE PASSWORD PROTECTION

You can enable password protection for a configuration file. If you enable pass-
word protection, users will not be able to view or modify the configuration file
without the assigned password. A password is not required to use the configura-
tion file with Aventail Connect.

T9 er-elm. Pas_5word .Pr9t!=_sti°n

1. From any tab of the Contig Tool, select File | Set Password.

!u‘wi-':':l.1l=I'fi\rHr:lnli l:fr._

nmnn as-_i:i-all up-. ' -unau ...,-nu-3-i 
The Configuration File Password dialog box will appear.

2. Enter the desired password.

3. Reenter the password to confirm. and then click OK.

Aventait Connect 3.1/2.6 Adniinistratofs Guide - 6?

 

Petitioner Apple Inc. — Exhibit 1022, p. 289



Petitioner Apple Inc. - Exhibit 1022, p. 290

Administrator's Guide

.-T°. .“.i§€.'..’!°. P??‘.5$F!".'.5.’.'..'.‘.‘ E?_".’*.°.9EiS’..T.‘ .

1. From any tab of the Config Tool, select File | Set Password.

The Configuration File Password dialog box will appear.

2. Clear the password from both boxes, and then click OK.

NOTE: if you save an existing configuration fiie using the Save As com-
mand, Avenrtaii Connect will prompt you to enter the correct pass-
word for the configuration file.

 

MULTIPLE FIREWALL TRAVERSAL

To gain access to your extranet. users may need to‘ traverse rnulfipie firewalls. In
the simplest case. this involves an employee at a partner company gaining
access to the Internet via an outbound proxy server at the partner company, and
having an authenticated. encrypted. and controlled c_onn_ecti_on_to your internal .
network via an Aventail Ext__r_aNet Server. This..c_apat:i_lity-_isptgv:id_egl_',in;-AventailI-_=__= _
Coilnest .3,-.1 biv.—..t.l.ie iw'.e.tr1t=.a.Iil..Ililt_s.ltiE’rr=..><si.featu.re..-fixentai! C.»‘..::.«n.I19c.t..c.:at'.r.i;-.v-t:.r:'>.e;i.1..r.=.s:n'-‘
ne¢tions._through SOCKS servers, through HTTP ‘proxies. or. through proxy '
chaining.

- MultiProxy with SOCKS Server: Uses a SOCKS server to control out-
bound access.

- MultiProxy with HTTP Proxy: Uses an HTTP proxy to control out-
bound access. '

- Proxy Chaining: Uses two Aventail ExtraNet Servers. where one
Aventail ExtraNet Server acts as a client to another Aventail ExtraNet
Server.

AVENTAIL MULTIPROXY

The Aventaii Multl Proxy..featu.r.e allows .Av.en.ta.iI.Qoo.nect..to'-"traite'r.se..rnultiple '
walls bii.m..a:k.ino connections. th'r9uo.h suO.C.9§5i.V9 pr..o>.<v..servers...A.v.entaii-.C:.qn:"'
nest _makes. a <.=.<=.r1I.1e..9.ti.<=.n..~uitl1 "each proxy server. indii'r.id,u.al.l3t. Each. P..I’9.>.<3t..§9.|'.\I9I-'-..:
forms a. link in a" -chain thjat'oo'n__nects Aventail-Connect to". the final destination.
Any or all of the proxy servers can apply authentication and access control rules.

Proxies can be Aventail ExtraNet Servers, other SOCKS 5 servers, SOCKS 4
servers. or HTTP proxies.

Using an HTTP proxy server to control outbound traffic eliminates the need to
install a separate SOCKS server. This HTTP proxy can fitter outbound connec-
tion requests and route those requests to the specified servers. MultiProxy sup-
ports RFC 2068 HTTP Basic (u sernameipassword) authentication. If your proxy
uses HTTP Basic (usernameipassword) authentication, Aventail Connect will

store the username and password information in the credential cache. as it does
with SOCKS servers.
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NOTE: The Mum'Proxy feature supports the use of HTTP proxies in
Aventail Connect 3. 1 only: HTTP proxies cannot be used in Aven-
tail Connect 2. 6. .

The steps for making a connection using MultiProxy are:

1. The client application requests access to the destination server.

2. Aventail Connect establishes a connection with the outbound server (SOCKS
server or HTTP proxy). Aventail Connect then sends the access request to
the outbound server, specifying the Aventail Extrahlet Server as the destina-

tion. The user authenticates with the outbound server. if necessary.

3. Aventail Connect instructs the outbound server to establish a connection with

the Aventail Extrahlet Server on the specified port. The user authenticates
with the Aventail ExtraNet Server, if necessary.

4. Aventail Connect instructs the Aventail ExtraNet Sewer to proxy its connec-
tion to the final destination.

5. Once the connection between the client and the Aventail ExtraNet Server is

established, the outbound server simply relays the date.

The following example illustrates the connections made during a MultiProxy con-
nection through three proxy servers.

REE
Avaiail Cornet! proxy 1 ptuxv 2 proxy 3 find deiinaticn

connection #1  :S¢KS : :

:5OCKS :

connection #3  u—u—unnnmu1nna&¢:SCCKS I

  

I
I

connection 192 EWHmwimna ne;. :
I

 

unqluuuimmunmuuusienna-anus-up
cornection #4 i-mm--as
 

In the "following diagram." tfie_Av'e*ntail' Ex_traNetacts _a'_s_b_dth"a _d9str'rratfoi__1'f=.f.-
and-a_. serves It is‘-‘qt destination. because a t'o1:tes.t'raffic'to':it-. ur-3. ax;
server-because -it routes. trafltc to the final'destination;

 

outbound proxy server Am-.-ntail Exilrahlet
Center server
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CAUTION: if usingan HTrP'proxy, you must configure your HTTP
proxy and firewai! to aiiow HTTPS/SSL connections to

port 1080. OR you must run the Aventaii ExtraNei‘

Server on port 443 or port 563.

Configuring Aventait Mui'tr'Proxy

You have two options for configuring MuItiProxy. You can configure Aventail
Connect 3.1 to redirect all Internet traffic (inciuding extranet traffic) through your
outbound proxy. or you can configure Aventaii Connect 3.1 to redirect only extra-
net traffic through your outbound proxy. -

7°.°°i"‘9Fi"'?..§’*?{?'1F§"..'fli!i?!?"9.¥Y _ _.

1. Create a destination ("Final destination").

2. Create a server ("Extranet server").

3. To redirect only extranet traffic: Create a destination (“Extranet server’),
using the same information from step 2. above.
.OR.

To redirect all lntemet traffic (including extranet traffic}: Create a destina-
tion ("Local network,” the network local to Aventail Connect).

NOTE: if you have muitipie domains or subnets, you may need to create
multiple desrina(fans. 

4. Create a server ("Outbound proxy"). This can be a SOCKS 5, SOCKS 4, or
HTTP proxy server.

5. Create a redirection rule (Redirect "Final destination” through “Extranet
server”).

6. To redirect only extranet traffic: Create a redirection rule (Redirect “Extra-

net server” through "Outbound proxy”). Do not redirect "(everything else).”
.oR-

To redirect all Internet traffic (including extranet traffic): Create a redirec-

tion rule (Do notredirect "Local network“). Redirect "(everything else)" through
the outbound proxy. (NOTE: Your outbound proxy must belong to "Local net-
work”) '
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Redirect oniyuihe ex1a_'aneTraffic lh rough Redirect all Internet traffic through the
the outbound proxy. Leave all other outbound proxy. Leave only “Luca! network‘
traffic alone. traffic alone.
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Pnoxv CHAINING

Proxy chaining is an Aventail ExtraNet Server feature. With proxy chaining,
Aventail ExtraNet Servers forward connections for certain destinations to other
proxy servers.

The following diagram and table illustrate the differences between Mu1tiProxy
and proxy chaining. In many cases, MuitiProxy is the preferred method for tra-

versing multiple firewalls With |Vlu|tiF’roxy, each proxy server can provide
authentication. access control. and encryption.

99.0%‘! EHAINING: Server: appears as a user to serverz.

 
 

 
  
 

Destination server
(fiventeil Extrehlet

Server)

Destination server
(Av-entail Extraflet

Server)

<1-:i'> Autherruzated and e1'r:ryptedtunne|
In M.i|tiProxy, an authenticated and encrypted
tunnel exists between the ciient and the Avental
E xtrehiet Server.
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Can be Aventail ExtraNet Must be Aventail ExtraN 

 
 
 

 

 
 
 

 

    

Server. other SOCKS 5 server. Server.
SOCKS 4 server. or HTTP
Proxy-

Must be Aventail Extrahlet Must be Aventail ExtraNet
Server. Server.

Authentication User authenticates (if User authenticates.
to Sewer 1 necessary).

Authentication User authenticates. Serveri authenticates

to Server 2 [ automatically.  Tmsl model for [ Not inherited. Each user must inherited from Server 1. Server
Server 2 individually authenticate with 2 trusts everyone who

Server 2. authenticates to Server 1
equally.

  
  
  

 
 
  

 

i—— .
Access control -Can be for specific users.
rules Treats everyone who

authenticates to Server'1

equally.

 

    
Client

configuration
redirection rules

 
Advantages - Server1 can be an Aventeil - Client is aware of Server 1

ExtraNet Server, other SOCKS only. _
5 server, SOCKS 4 server, or - User authenticates only once,
H1'|‘P proxy. to Server 1.
- Most secure. because no

security policy is inherited from
Sewer 1.

Disadvantages - User may need to authenticate - All users connecting through
more than once. Server 1 appear as a single
- Client must be aware of user to Server 2.
Server 1 and Server 2.
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HTTP PROXIES AND WEB BROWSERS

Extranets often include Web pages that must be viewed with a Web browser.

When a Web browser uses an HTTP proxy server, Aventail Connect sees con-
nections being made to the HTTP proxy rather than to the final destination.
Therefore, Aven tail Connect cannot redirect the connections to the Aventail

Extrahiet Server or provide authentication and encryption. For Aventail Connect
to function properly, the Web browser cannot use the H'l'l'P proxy to connect
with sites protected in the extranet; this is because Aventail Connect must redi-

rect and encrypt connections. The Web browser can still use the HTTP proxy to
connect to sites that are not protected in the extranet.

If access to Web pages behind the Aventail ExtraNet Server requires users to
connect through a Web browser (e.g., Microsoft Internet Explorer or Netscape
Navigator). you must configure the Web browser to not use the HTTP proxy in
the Web browser for those sites protected in the extranet.

when users need to access Web pages behind an Aventail ExtraNet Server, you
must properly configure the Web browser.

Configuring Aventaii Connect and the Web Browser

There are two approaches to configuring Aventail Connect for use with a Web
browser.

- Configure the Web browser to not use the HTTP proxy for any traffic.
(Aventail Connect redirects all connections through the outbound
PTOXY-)

-09-

- Configure the Web browser to not use the HTTP proxy for only those
sites that are protected in the secure extranet. (Aventail Connect redi-
rects only extranet connections through the outbound proxy.)

To use either approach. you must first configure Aventail Connect. The Aventaii

Connect configuration is the same for both approaches, whether you are config-
uring your browser to not use the HTTP proxy for all traffic or for protected sites
only. -

___T£.E2'_‘§‘.2ti£‘?_“5L°_Fl!:‘“' Connect for use zvith 5! Web browser

1. in the Servers tab of the Config Tool, add the HTTP proxy as a server.

2. In the Destinations tab of the Config Tool, add the HTTP proxy as a destina-
tion.

3. in the Redirection Rules tab of the Config Tool, edit the "(everything else)"
rule to redirect all traffic to the HTTP proxy server.

4. in the Redirection Rules tab, select the HTTP proxy and select the Do not
redirect option.
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CA UTION: Make sure you do not redirect the outbound proxy.
Redirecting the outbound server or proxy will‘ instruct
the outbound proxy to redirect iraffic to itseif, causing
Aventaii Connect to behave unpredictabiy.

To configure the Web brotvser to _not_use the I-_I[TP proxy _for_aIl traftic

After you have configured Aventail Connect by following the instructions above,
configure the Web browser by using one of the following procedures.

- Microsoft Internet Explorer

a. On the View menu, click internet Options.

b. Click the Connection tab.

c. Click to clear the Access the Internet using a proxy server check box.

- Netscape Navigator

a. On the Edit menu, click Preferences.

b. Under "Category," click to expand Advanced. and then click Proxies.

c. Select Direct Connection to the Internet, and then click OK.

To configure the Web browser to not use the HTTP proxy for protected

After you have configured Aventail Connect. configure the Web browser by
using one of the following procedures.

- Microsofl Internet Explorer

a. On the View menu, click Internet Options.

b. Click the Connection tab.

c. Under “Proxy Server," click Advanced.

:1. In the Exceptions box. type the URL of each site that is in the protected
extranet.

- Netscape Navigator

On the Edit menu, click Preferences.

Under "Category," click to expand Advanced. and then click Proxies.

Select Manual Proxy Configuration, and then click View..0-°.'3'9’
In the Exceptions box. type the URL of each site that is in the protected
extranet.
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CONFIGURING THE HTTP Pnoxv

To allow SSL connections to destination ports other than 443 (https) and 583
(snows). you may need to configure your HTTP proxy. Typically. if you plan to
connect to a SOCKS server on port 1080 using an HTTP proxy, you must
change the HTTP proxy configuration.

To avoid changing the HTTP proxy configuration. you must run the destination
Aventail ExtraNet Server on port 443 or port 563. and configure Aventail Con-
nect accordingly.

Most HTTP proxies can allow connections to port 1080. The following instruc-
tions describe how to configure the Microsoft Proxy Server, Netscape Proxy

- Server, or Apache Web Server to allow port 1080 connections.

- Microsoft Proxy Server 2.0: Follow the Microsoft instructions at

http:itsupport.tnicrosoft.comlsupporttkblatticlestq184lDl28.asp.
You must modify a registry setting with regedt32 . exe.
(regedit . ex-e will not work; you must use rege-dt:32 . axe.)

- Netscape Proxy Server 3.5: Add the following to your obj . conf file:
<Object ppath=”connect : //*’'> (at! ports)
Service fn="connect” method=”CONNECT"

</Object>

To specify a particular port, add the following to your obj . conf file:
<Object ppath="connect://*:10B0"

- Apache Web Server 1.3.2 (Linux) with Proxy Support: The fottowing
two lines must be included in the httpd . co nf file:

Proxy Requests on

Al lowCONNECT <porr. list'.> (NOTE: This feature is available only
on version 1.3.2 and greater.)

EXAMPLE NETWORK CONFIGURATION

The following section describes the setup of Aventail Connect in an example net-
work configuration using the Aventail ExtraNet Server.

CONFIGURATION USING AVENTAIL EXTRANET-SERVER

The _roil.owins.examp!‘s .r3e.twor.lx .c9nfis_urst.i9ns, show .'_tiJ_a .A.ven_t_aii .E,xtraN_st ._ _.
Serve: .c_=9nfieured..tor.a .Mobi.la .Extranet.envirqnment..and. .a._.F.'_artne,r Extranet
en_yironmen_t;_ This __exa__fr_1_ple- emphasizes simplicity to facilitate easy-adaptat_ion'to --
real world-network designs.
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The design used in the example above consists of two individual Ethernet seg-
ments, one public and one private. The public segment is used to host anony-
mous services available to the general public. The public access is provided
through a router that is connected to the public Internet. The private segment is
used to house all of the corporation's private network resources and data to be-
used only by internal company employees. The Aventail ExtraNet Server

depicted in this example is used to provide secure and monitored access to the

private LAN for mobile employees and partners. For security reasons the Aven-

tail ExiraNet Server is configured such that operating system routing is disabled.
Therefore, no direct network connections between the public LAN and the pri-
vate LAN can be created without being securely proxied through the Aventail
ExtraNet Server.

The mobile user workstations connected to the public Internet are the client

workstations, onto which. Aventail Connect will be deployed. Due to the routing
restrictions described above. these clients will have no network access beyond

the Aventail ExtraNet Server unless they are running Aventail Connect. Depend-

ing on the security policy and the Aventail ExtraNet Server configuration. Aven-
tail Connect will automatically proxy their allowed application traffic into the
private network. In this situation. Aventail Connect will fOl'Wal'd traffic destined for

the private internal network to the Aventail ExtraNet Server. Then. based on the

security policy. the Aventail Fottrahlet Server will proxy mobile user traftic into the
private network but only to those resources allowed. The client workstations we
focus on in this section are Microsoft Windows based PCs.

The Aventail B<traNet Server in our example. has two network adapters config-
ured to use the internal IP address of 10.1.1.1 and an external address of
129.79.100.64.
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CAUTION: Since the intemai network address space is part of the
' iANA reserved address space (per BCP RFC 1918)

routing MUST be disabied on this host and routing
advertisements for this internai network MUST NOT be
propagated to the outside worid.

User_.authsnI_isati9nend.__eni=rvpti9n on,tl1e. £w9.n!ail.resil.ir.9.e1I.;; _
users to'.juse_.Avantail= Connect to_ .authenti9at.r;a.nst.'e_nctypt th.alr_.$essi9ns.bet_bre. '
anY.connecti_on_to_the internal private networkts). For this example, the'Aventail - -
Ext'r'aNet Server encrypts all sessions with_SSL-;j

SEE ALSO: For additional information on how to configure the
Aventaii ExtraNet Server product, consult the Aventail
ExtraNet Server Administrator's Guide.

installing and using Aventail Connect for remote access purposes differs a bit
from its installation and use within a corporate network. First. configuration files
need to be kept locally on the workstation or laptop. This is due to the inability to
share a file server that allows direct access outside the perimeter of the private
network. Second. not all traffic passes through to the Aventail ExtraNet Server.
Only traffic destined for the internal network is authenticated and encrypted; all
other traffic passes through Aventaii Connect unchanged. For instance, brows-
ing the lnternet from the mobile user workstation occurs as if Aventail Connect is

not even running in the background, Large sites with many mobile users will
want to set up an internal file server for a network installation for all mobile users

to easily install and configure Aventail Connect. For more information. refer to
"Network installation."
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This section explains:

- Commands on the System menu, including Close, Hide Icon (in Win-
dows 3.1, Windows for Workgroups 3.11, and Windows NT 3.51}, Help,
About. Credentials, and Configuration File

- How to use the Aventail Connect utilities, including the Config Tool, the
Logging Tool, and S5 Ping, all displayed through the Utility Programsmenu.

- How to use Secure Extranet Explorer (SEE)iExtranet Neighborhood.

SYSTEM MENU COMMANDS

Even though Aventail Connect requires little to no interaction with the user, there
are commands on the Aventail Connect System menu. To display the System
menu, right-click the Aventail Connect icon in the system tray on the taskbar
(Windows 95, Windows 98, and Windows NT 4.0) or click the minimized Aven-

tail Connect icon (Windows 3.1, Windows for Workgroups 3.11, or Windows NT
3.51).

Aventail Connect System Menu Commands

  
Hides the Aventail Connect icon from view. Not available in

Windows 95. Windows 98, and Windows NT 4.0.

Accesses Help.Help -

Configuration File Selects new configuration file via Aventail Connect

configutation Fite dialog box.

Each of the commands is discussed below.

CLOSE

This command closes Aventail Connect. Exiting Aventail Connect may limit
access to certain remote hosts or prevent ‘you from using certain ‘MnSocl< appli-cations. '
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HIDE icon

This command hides the Aventail Connect icon from view (Vtfindows 3.1, Win-
dows for Workgroups 3.11,- and Windows NT 3.51 only). Aventail Connect will
run in the background. The Hide icon command is not avaiiabie in Windows 95,
Mfrndows 98, and Windows NT 4.0.

HELP

This command accesses Aventail Connect Help.

ABOUT

This command displays the Aventail Connect About box." which includes Aven-
taii Connect software copyright notification, version information, and so on.
Clicking More displays a list of files used by the current version of Aventail Con-
nect.

CREDENTIALS

This command displays the Manage Credentials dialog box. Credentials
include the information (such as usemameipassword) that you enter when
establishing a connection to an extranet (SOCKS) server requiring user authen-
tication. (Aventail Connect prompts you with an authentication dialog box.) As
long as your credentials are in memory. you can establish connections to associ-
ated extranet servers without needing to reenter your authentication information.

You cannot edit credential data fields; you can, however.- delete individual cre-

dentia! entries. Aventail Connect will prompt you to enter updated authentication

information when you reestablish a connection to the associated extranet server.
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NOTE: You cannot edit the "AUTHlNFO" entries in the Manage Creden-
- rials dialog box. This information is for diagnostic purposes oniy.

Extranet (SOCKS) server name.s5cl<s Servei:

User Name User name for the extranet server.

Authentication method.
 
T.°..ds|.!-=.te. .3 °r¢d9nFi.aJ...9n?rv. .. .. .. _

Delete authentication credentials when they are no longer correct. After the cre-
dentials are deleted, you will be prompted to reenter them the next time you con-
nect to the associated extra net server.

- Select the credential entry you want to delete and click Delete.

This deletes the credential information.

. .T..‘!..‘?’..‘..'_*..*?‘.‘?. '‘*‘.'*'.'‘.?!9.*‘-‘. 9."’.‘.'°".*.i.a."5 ‘.3.ial'9.9 .‘?9.’F .

' Click OK to accept changes to the credentials and close the dialog box.
.05».

' Click Cancel to close the dialog box without accepting any changes you
might have entered. '

NOTE: Ciicking Appiy saves changes but keeps the diaiog box open so
you can keep wanting.

CONFIGURATION FILE

This command lets you load a different configuration file via the Aventail Con-
neot Configuration File dialog box. Aventail Connect 3.1 allows you to use a
new or modified configuration file immediately, without needing to restart Aven-
tail Connect and any Aventail-processed applications.

For more information about the configuration file, refer to "Configuring Aventail
Connect."
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' Select the configuration file you want to load (use the Browse button), and
then click OK.

* If you want Aventail Connect to start automatically with your most recent

choice of configuration file, select the Automatically start... check box, and

then select the start delay (in seconds).

The new configuration file transparently loads into Aventail Connect. You

can close and restart Aventail Connect for your change to take effect. or

wait the specified length of time if you selected the Automatically start...
checkbox.

UTILITIES

To display the Utility Programs menu, right-clickthe Aventail Connect icon in
the system tray on the taskbar (vtfandows 95. Windows 98. or Windows NT 4.0)
or click the minimized Aventail Connect icon (Windows 3.1, Windows for Work-
groups 3.11, or Windows NT 3.51). -

t_ConAventai nect

 

 

  

  Logging Tool

S5 Ping Runs the ping and traceroule utilities. (Optional)

Runs the Logging Tool. (Optional)

Each of the commands is discussed below.
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NOTE: The Config Tool. Logging Toot, and S5 Ping commands are
optional components and wiii only appear when the netwonft

administrator has inciuded them in a custom setup package.
They are discussed in the sections “Configr Toot, " “Logging Tool,"
and "S5 Ping.” -

CONFIG TOOL '

The Aventail Connect Config Tool creates configuration files that determine how

network requests will be routed and which authentication protocols will be
enabled. (This option may not be avaiiabie to aii users if the network administra-
tor has chosen not to instaii it.)

5 =" i_:ClE1-ill} I uni - ‘

 
Network administrators generally create configuration files during Aventail Con-
nect installation. However, you can add, remove, or modify configuration files at
any time. If necessary. you can create several configuration files for different

users or user groups. Some configuration files may reside on a networked drive.
accessible by multiple users. Other configuration files may be tailored to a spe-
cific user on an individual workstation. "Configuring Aventail Connect” discusses
the Config Tool in detail. '

Loecme Tom"

The Logging Tool is an optional diagnostic utility for tracing Aventail Connect and
Winsock activity. When running a trace, the Logging Tool displays errors. warn-
ings, and information as Aventail Connect generates them. You can save the
message list to a log file that Aventail Technical Support can use in troubleshoot-
ing technical problems. including Aventail Connect network, extranet (SOCKS)
server, and Vlflnsock application interoperability problems. Aventail Technical

Support engineers may request that you perform a verbose trace, log it to a file,
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and e-mail it to them as an attachment. Log files are also useful when running
Aventail Connect for the first time, to ensure that network traffic is being routed
properly.

T9. trace .Aventai.|. .¢9rLns9!. a°tivit.2.....

1. vlfundows 95, V'l/il1C1OWS 98. or lmndows NT 4.0: Either right-click the Aventail
Connect icon (in the system tray on the taskbar) and click Logging Tool. or
select Start | Programs | Aventait Connect| Logging Tool.

.052.

Vlfindows 3.1. Windows for Workgroups 3.11. or Windows NT 3.51: From the
Aventail Connect program group. double-click the Logging Tool program
icon.

i ruaacm Running an wins... ' 12.1 9
l'fla4elJ1 Redirecting cnnn... j‘: 12fl]8!9fl

5 0 fflae319 CCM: Authenlicati,.. _' 12103298
JO flfallefll Redirecting conn... IZIOBIBB

fl'fae319 CCM: Authenticati _ 12llJBf98
_. i fflaaleflt Redirecting coon... " 12108398

.i ffIa4e01 Redirecting conn... 12110131913
To fflae319 CCM: Autnenticati 12.f08{98
_ O ffiae319 CCM: Authenticati 121031198
(D flfa-1901 Netsocket revcvfl... " 12iflfl!9fl

'. 0 fttaelefll NetSnc|ret revcvfl .. 12.tlJ&f9fl .
‘Q lfia4e01 Redirectinq conn

2. In the Log menu. click Level and select one of the five levels of information
you want to trace.

-QR-

Select one of the five levels from the drop-down list on the toolbar.

11:00:29

11:00:29
11:00:29
11:00:39

11:00:39

11‘0lJ:39mg 1 ,
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Fatal errors only

llirrorsl-zairid fatal only

Errors and warnings only

Errors, warning. and information

All of me above. and more descriptive information on progress of
connections

 
3. On the Log menu. click Trace.

.09.

Click the Trace On button on the toolbar (shown below).

..:,-'i Logging Tool

  

 

2; 

The log window will now record and display trace information as it is generated
by Aventail Connect. You can tell when the trace function is active because mes-

sages are scrolling down the screen and the Trace On button is depressed.

4. When you are ready to stop the Trace function. click Trace on the Log menu.
'-OR-

Click the Trace Off button on the toolbar (shown below).
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The Trace function stops. You can now scroll through the results, print them,
andlor save them to a file.

‘l_'o save a log file-

The Logging Tool allows you to append each new message to the end of a . LOG
file during the trace, or save the contents of the log window at any time. if you
save during a trace, Aventail Connect will append messages to the log file until
you stop the log function. You must save data in the log window to retain it.

You cannot open a preexisfi ng log file from within the log window. To open a pre-
existing log file, you must open it in a text editor such as Notepad.

1. To save a log file as the data is being generated. click Log to File on the Log
menu. Enter the filename in the Select Log File dialog box.

-053-

Click the File Logging button on the toolbar (shown below).
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2. Enter the filename in the Select Log File dialog box.

- To save the contents of the log window at any time. click Save As on
the Log menu and then enter the filename_

7° fi'tf°.'. '“°‘.”5"9F*.5 ."‘. .*T.‘.‘_’_..'.F?9.. "!“_'.iF?_“.'_‘?'_‘f" __

You can filter the contents of a log window by selecting the types of messages

you want to view. By selecting a specific type of message. you can easily scan
the information on-screen. If you save data to a log file, a view filter will not affect

the file contents; it merely adjusts the screen display of those contents.

1. On the View menu. click Filter Messages to display the Filter dialog box

.oR.

Click the Filter button on the toolbar (shown below) to display the Filter dialog
box.
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“tar  

 

NOTE: The Filter function is an on/off toggle. If the filteris enabled,
seiecr Filter Messages to turn it off, then select it again to dis-
play the Filter dialog box.
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.-"r. "'...

Select any of the five filters to display errors. fatal errors. warnings.
information andior verbose information in the log window.

Log Type Seiect the type of log to be fiitered. (Currently. the only valid log
type used in Aventail Connect is Miscellaneous.)

messages from 32-bit applications.‘;At3i>iac'éi'a"§Ei
Type‘

‘These options are disabled if you are running 16-bit Windows.

 
2. Under "Categories." select one or more of the five filter check boxes. The log

window will adjust the display based on your selection(s).

3. Under “Log Type," select the tog type to filter.

4. Under “Application Type," select one or both of the check boxes.

To change the view pararneters

The display font and window options can be customized as follows:

' On the View menu, click Font. Enter your font preferences into the standard
Windows Font dialog box.

° To display or hide the toolbar and status bar, dick Toolbar andior Status
Bar on the View menu.

To copy the log window

You can copy the log window contents to the Windows Clipboard.

* To copy all of the log window contents to the Windows Clipboard, click
Select All on the Edit menu. Then click Copy on the Edit menu. or click the
Copy button on the toolbar.

' To copy selected messages to the Vtflnclows Clipboard, drag the mouse over
the messages to highlight them. Then select Copy on the Edit menu or ctick
the Copy button on the toolbar.
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_I9.9r.i!!_t_ t!1s,!°9 window

You can print the contents of the log window can be pn'nted only in its entirety.

' On the Log menu. click Print.

.05».

Click the Print button on the toolbar.

The entire contents of the window will print. regardless of whether you
have specific messages selected. If you have filtered the display, only the
filtered messages will print.

'_r_D_fi_l'l(fl§pBCifiC message

The Find command will only work with data displayed in the window. if the dis-
play has been filtered. only the filtered messages will be searched. The Find dia-
log box remains active until you close it.

* On the Edit menu, click Find.

-0 R-

Click the Find button on the toolbar. _

Then enter your search parameters in the Find dialog box.

I9 9'sa.r_the.._!99 w.i-"!is_!sas2‘.._l

Clear the log window contents when you are ready to execute a new trace.

' On the Edit menu. click Clear All. '

_oR-
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Ctick the Clear A1! button on the toolbar.

. T9. °'°?°. "*9 _‘.‘.?9. "."‘.'_“?‘F’.‘.'_"'

When you are ready to close the log window. make sure you have saved the
contents of the trace for later reference. All settings are saved when you exit.

' On the File menu. click Exit.

85 PING

Two of the most useful diagnostic tools in an administrator's arsenal are the ping
and traceroute utilities.

- The ping utility. checks for network connectivity between two hosts and
returns information about the quality of the connection.

- The traceroute utility checks for network connectivity by displaying
information about routers between two hosts. It displays information for
each hop.

Ping and traceroute both use Internet Control Message Protocol (ICM P).
SOCKS v5 is designed to handle TCP and UDP protocols; however, SOCKS v5
does not support ICMP. Because ping and traceroute are based on ICM P. there
is no way to directly proxy a ping or traceroute request. To circumvent this prob-
lem. Aventail Connect provides a utility called 85 Ping.

S5 Ping determines whether a host outside of an extranet server is active. After
a response from the host returns, the extranet server relays the data back to the
client and displays it in the S5 Ping dialog box.

To launch 85 Ping

I You can use 35 Ping whether or not Aventail Connect is running. However. it the
server that you are connecting through requires authentication. you must load
Aventail Connect before reconnecting.

° Windows 95. Windows 98, or Windows NT 4.0: Select Start | Programs ]
Aventail Connect | 85 Ping.

-QR-

Windows 3.1. Windows for Workgroups 3.11. or Windows NT 3.51: From

the Aventail Connect program group. double-click the S5 Ping program
icon.

-QR-

If Aventail Connect is already running, right-click the Aventail Connect
icon on the taskbar and click S5 Ping (‘Windows 95. Windows 98, or Win-
dows NT 4.0). click the minimized Aventail Connect icon in the System
menu (Windows 3.1, Windows for Workgroups 3.11, or Windows NT 3.51).
The S5 Ping dialog box appears.
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.. -.

 

NOTE: S5 Ping will function without a property configured Aventaii Con-
nect; however, the user wiii be required to type the information
about the target extranet server and target host into the SOCKS
Server and Destination boxes.

 

 
 

 

 The Extranet (SOCKS) server that will execute the

operation. If Aventail Connect is already configured, this list
will be preloaded with extranet servers from the
configuration file.

 
 
 

 
 

  
 

Destination The extranet server you we nt to ping (or traceroute). If
Aventail Connect is already configured. this list will be
preloaded with single host destinations defined in the

configuration file. (See "Configuring Aventeii Connect’)

The results of successful oonnection. The format of the
results will vary based upon the extranet server platform., __l_ ._..

 
  

    
  

S5 Ping can be used whether or not Aventail Connect is running. However, if the
server that you are connecting through requires authentication. you must load
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Aventail Connect before connecting. The network administrator may or may not
make 85 Ping available to users during installation. in some cases. the S5 Ping
command will not appear on the Aventail Connect System menu or in the pro-
gram group.

Once the S5 Ping dialog box opens, you can execute a ping or traceroute net-
work operation.

7° '_.‘.‘.?" R5 ‘.19. 9'.’ .*_.'.".‘_.°..!’-'.'.‘.?’.“..F‘E_‘_‘§i.'."9._§5 “"9

S5 Ping has two modes of operation: ping and traceroute.

1. Under "Operation," select one of the two options. Ping or Traceroute.

2. Under "SOCKS Server," select an Aventail ExtraNet Server to carry out the
operation. If no servers are listed (because 85 Ping did not locate an Aventail
Connect configuration file). type the extranet server's hostname or IP
address.

3. Under "Destination," select a single host destination to ping or traceroute. If
no hosts are listed (because 85 Ping did not locate an Aventail Connect con-

figuration file). type the hostname or IP address of the host you want to ping
or traceroute

4. Ciick Start to execute the operation. Start then changes to Stop. Results
from any previous operation are cleared from the window.

5. if the extranet server requires authentication, you may be prompted with a
server certificate or required to enter a username and password. ( For more
information about server certificates and usernameipassword authentication,
see "Manage Authentication Modules" in the Administrators Guide.)

5. Once the connection to the host has been made, the information returned
from the server will be displayed in the Results window.

- Click Stop.

This stops the operation and changes Stop to Start. The results of the
operation remain displayed in the S5 Ping dialog box.

_ To exit 55 Ping

' Click Exit.

This clears the results and closes the S5 Ping dialog box.
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SECURE EXTRANET EXPLORER

Secure Extranet Explorer (SEE) allows you to view your Extranet Neighborhood,
which is accessed through the Extranet Neighborhood icon on your desktop-.
The Extranet Neighborhood user interface resembles that of Network Neighbor-
hood. However. while Network Neighborhood displays all oomputers on your
local network. Ex‘F§D..eI.N.Bi9!'!i?°_Fh°Qd;8!'9iiY$ sr.s>.i.i t9._iitowse...9.9py,. _r.1i.9ve..'.:...-.f=i.ri.c't-;,-.-,
de.|.e.te .fi.1.es from l'_t'9_rI1.0_t_Q.,‘.?9i‘I1l??Ut..9F.8.'?4i.3.lh&.A\i’9_F]!§ii_-QQIIHBCI9Kft'§l'|'€t..¢¢fln9¢r"
t.i9_o.._.iMtti.Ext_ran.et_Neioht;ori1i2oci. a!|.intera.cticin.withtharemote.sery_er._¢an..b‘e-..
secured. .;~l_ef¢work_a<irninistrators determine which local and remote computers?
are available to ‘users';.?

NOTE: Some instaiiations of Aveniaii Connect may not inciude SEE.
Network administrators can decide whether or not to include SEE
in a custom setup package.

Extranet Ne.loh.bornoo_c_i. a Winclows Explorer sheII...extension. I-3'. .a.t.:olI.e.c..ti¢'_:n- of.
Windows fi|.e'.serv'_er.'s and .\.M'n._d.<_>.ws. _l~.IT.:.ci.'<=.r.11ai.r_I.s..-.__Noti.~_,r,c:_r_I_<'N_e.iohtz9ih99s1 .<1is.-.=.; __
plays only_th.9s,&._re.m9te_c_9tnP_Ut_er§..that_.tl19 a..ri.i.n §tr.atot_i1§s.§o§qifi ' '-
SEE requires a hosts file (SEEI-_|osts) that dBf_6l.'_l’l'.lil'te§-.tiiihlch-:V\fiI1ddWs_-fi|é_-'_$6ni, -
eI_‘_'&'i'\:_a'l'_]§_I_,'.Iji"§' _domains_a_re_ __'aqa'ilable'_.' You. can incltide'a.S_EEHostS_fii_e.with
Aventail Customizer tool..lf users install a custom package that does not inciude
a SEEHosts file, then the first time they open Extranet Neighborhood, SEE will
create a SEEHosts file. For more information, see the "Customizer" section in
the Administrators Guide.

Extranet Neighborhood offers Aventail Connect users a secure alternative to tra-

ditional file-browsing methods. Users can securely access computers from the
desktop through Extranet Neighborhood (see icon below), or through Windows
Explorer.

 

 
Generally. you will use. .Ext_ran9.t Ne.l9h.borhO9.d to 'conn.ect..to a. .r.emot.e, .net.1~.o.rk..
through Aventail Cor'Ine_ct.- For example. you will use Extranet Neighborhood
when:

- "you. are inside the offi¢e‘.. on the .oorri9rate;f.h‘etw9.rié'..'..ahd y¢'L_.|;ia9nné¢t......;
through an Aver1taii_E:_<_jtraNet; Server to your c'ompany's'.ra_mot_e site‘; :or" '-
to. another company's network. .

- you are..'outsi_de ttie otfioe. andyoti connect-$?éu.r;.|a'pto'p.th.rOi:oH an.-.
Av_en_t__ail _ExtraNet Sewer to your internal oornpany network'.' or to
another company's network.
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NOTE: To use Extranet Neighborhood with remote hosts, Aventaii Con-
nect must be running and configured correctly. 

How EXTRANET NEIGHBORHOOD WORKS

Typically, with Windows networking, the Microsoft Windows Explorer and Net-
work Neighborhood browse files using NetBlOS (NBT), over TCP. Network
Neighborhood does not use the standard \NnSock programming interface. This
prevents Aventeil Connect from redirecting TCP connections. Since Aventail
Connect redirects only Winsock calls, it cannot redirect NBT calls.

To deliver a secured version of standard Windows browsing, Aventail Connect
redirects NBT calls to Winsock. This allows Aventail Connect to redirect this traf-

fic based on a set of redirection rules, as defined in the Aventail Connect config-
uration file.

Extranet Neighborhood can use either hosts files or Windows Internet Naming
Service (WINS) servers to map a computer’s Internet (host) name to its Win-
dows machine name. Without a hosts file or a WINS server. Extranet Neighbor-
hood cannot associate a computer’s Internet name with its Windows machine
name.

Extranet Neighborhood includes a browsing mode. which allows you to view a
dynamic list of available Windows hosts. Hosts files provide a static list of hosts.

There are two basic methods for configuring Extranet Neighborhood.

- Listing WINS Servers: List only WINS servers for the domain(s} in the
hosts file. You do not need to list individual hosts within the domain.

o Listing individual Hosts: List every individual host in the hosts file that
will be accessible to users.

LISTING WINS Ssevsns

To use Extranet Neighborhood in the browsing mode, you must configure Extra-
net Neighborhood to use WINS. and you must identify the IP address (host-
name) of the WINS server(s) and, possibly, the primary domain controller (PDC)
for the domain. If you do not specify a WINS server, you will not be able to use
Extranet Neighborhood in the browsing mode.

The PDC for the domain is required only if the destination network is not acces-
sibte by UDP. (For example, when using MultiProxy, the destination network is
not UDP-accessible.) When Extranet Neighborhood is in browsing mode, it must
be able to resolve the name of the host. If the destination network is UDP-acces-
sible, then the WINS server is used to map a computer’s Internet (host) name to
its tmndows machine name. If the destination network is not UDP-accessible,
then Extranet Neighborhood uses the PDC and DNS to determine the host's
address,
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LISTING INDIVIDUAL HOSTS

To use Extranet Neighborhood in the static host list mode. you must define. in
the hosts file. each individual host in the domain. This allows you to restrict-
aocess to designated hosts only. In the hosts file. you must specify the host's IP
address or DNS name along with the Windows machine name. WINS and PDC
are not used in this method.

INSTALLING EXTRANET NEIGHBORHOOD

When installed, Extranet Neighborhood appears on your desktop as an icon,
and in Windows Explorer. You can open. move. copy. and delete files in Extranet
Neighborhood just as you would in Network Neighborhood.

If you need to install Extranet Neighborhood, install it from the Aventail Connect
CD. Or. if you downloaded_ your copy of Aventail Connect, run the downloaded
executable package. when the Installation Components and Sub-corrIpo-
nents dialog box appears. select Extranet Neighborhood (located under Com-
ponents). Continue with the installation process.

The default installation directory is
\Prc>gram Files\Aventail\Connec:t.

NOTE: Secure Extranet Explorer/Exrranet Neighborhood is available

only on lrwndows 95, l/Widows 98, and Windows NT 4.0 operat-
ing systems.

 

CONFIGURING EXTRANET NEIGHBORHOOD

You can include a SEEHosts file with the Aventail Customizer tool. Only by
installing a custom package will users have a local or remote hosts file

automatically configured. If users install a custom package that does not include
a SEEHosts file. the SEE Configuration wizard will run when users open
Extranet Neighborhood for the first time. The SEE Configuration wizard walks
you through the process of defining iocal or remote hosts files. Aventail
recommends that you use the Customizer tool to distribute Extranet

Neighborhood, bundled with a hosts file. in a custom setup package.

Extranet Neighborhood can automatically construct a hosts file from your local
network or a remote network. Using the Search feature, Extranet Neighborhood
can automatically “browse" available computers and build the local hosts file.

The Search feature is available through the Extranet Neighborhood Proper-
ties | Local tab. Alternatively. you can enter the names of the available comput-
ers manually. The Search feature browses only those computers that are within
your internal network. To search remote networks. you must manually enter the
fully qualified hostname of each remote WINS server that is outside your Aven-
tail ExtraNet Server. When using the Search feature. the same UDP restrictions
described in "Listing WINS Servers" apply.
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._ NOTE: To use the Search feature, Aventaii Connect must be running and
*3-'3 configured correctty.

Do not use the Search feature if you are using the WINS-browsing mode. The
Search feature builds the local hosts file for all of the computers. which is not
necessary with WINS. Use Search when creating a local hosts file using the “list-
ing individual hosts" method.

NOTE: When you click Search, you may see more than one domain in
the resuiting iocai hosts tiie. This is because Search inciudes
trusted domains.

 

...T°..‘3..".°.3..t.°...‘i!..,"‘.’.5*..'-'?.T“¢._. .

Use this procedure if you have not yet created a hosts file.

1. Decide which method, listing WINS servers or listing all individual hosts, touse.

2. If no hosts file exists. launch Extranet Neighborhood (Extranet Neighborhood
will prompt you automatically if you are running Ektranet Neighborhood for the
first time).

-OR-

Right-click the Extranet Neighborhood icon on your desktop and then click _
Properties.

3. Follow the on-screen instructions to create the hosts file.

4. To distribute the new hosts file, include the SEEHosts file in your custom
setup package, if using the Customizer tool.

After creating the hosts file, users can browse only those domains and machines
that the network administrator has included in that list of hosts. This list may be a
tocal hosts file called “SEEHosts” andior a remote host list. which is identified by
[share] \ [path] \ { E i la-name].

NOTE: To use the browsing. mode, you must specify the domain‘s WW8
server(s) in the toast hosts fiie.

CAUTION: SEE cannot recognize share names that contain speciai
characters {e.g., e) or muitiple spaces (e.g., Aventail
Custom Computer). SEE aiso wit! not recognize hidden
one-letter share names {eg.. CS or D$).
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SEE CONFIGURATION Merl-loos
There are numerous methods for configuring SEE. The three most common
methods are described below.

Local Hosts Fiie Method

With this method, the hosts file contains a list of all domains and servers in the
local hosts file. Every host is listed.

There are two ways to configure SEE using this method.

- In the Extranet Neighborhood Properties | Local tab. manually add
each domain and host to the local hosts file

-OR-

- On the Local tab. click Search, click Search Local Network, and then
search any remote networks. if necessary. SEE automatically builds a
list of all hosts. You may delete hosts from the local hosts file if you do
not want users to view them.

NOTE: To view your domains, double-click the Extranet Neighborhood
icon on your desktop. if you make changes to the hosts fiie, you
can reioad the Extranet Neighborhood domains window by
pressing the FE": key.

 

Remote Hosts File Method

With this method, the local hosts file contains the path of the remote hosts file,
and the remote hosts file contents are determined by which configuration
method you use.

To use this method. first create the remote hosts file, and then create a local
hosts file that points to the remote hosts file.

T9 9°F'T‘9F_".'.3 $.53 95!"9.‘..'ll.5..l‘£'_‘!9*° ."°§?5.I'.'E "?‘?*.'.‘°.‘.‘ . . .

1. Create a local hosts file, using one ofthe methods listed above. and copy it to
a central location. (This creates a remote hosts file; this file is not distributed
with Aventail Connect.)

2. On the Remote tab, click Add, and then add a pointer to the remote hosts file
that you created in Step 1. (This file is distributed with Aventail Connect.)

NOTE: You can point to muiiipia remote hosts flies on a single iisr. 
WINS Browsing Method

With this method, the hosts file contains a list of all domains, and the WINS serv-
ers for each domain. You do not need to list all of the computers.
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To use this method. add each domain in the Local tab. specifying the primary
WINS server and, if applicable, the secondary WINS server, and then select the
Make domain browsable check box in the Windows Domain dialog box.

Choosing a Method

Each of the three methods has advantages and disadvantages. The table below
lists pros and cons for each of the three methods.

 

  
I_E5_'i‘i'-' ‘as

Local hosts

.-I. -..42. -

The administrator

:4. .J.'.:_.

ministrator must update the  The ad local 
 

  
 
 

 
 

 
 

 
 

file with controls exactly hosts file if file servers are added to or
individual i which hosts the users removed from the domains.
computers can see. On slower

connections. this

method is fastest

since you do not
need to send a list of
serversto the client.

 
  

  
 

 
 
 

 
 

 

 
 

 
 

 
 
 

  
 
 

  
 
 

 
 

Remote hosts
file

' The administrator

can edit the centrally
' Users are immediately prompted to

enter authentication credentials upon
stored hosts file opening SEE (because SEE must load

whenever necessary. the remote hosts file).

' If the hosts file is ° If a user loses network connectivity to
stored behind a the hosts file. SEE will not display the list
firewall, SEE can go of hosts.-‘computers.
through an extranet
 

 server [using
encryption and

authentication) to
reach it.

The administrator

_ does not need to
update the hosts file

if new computers are
added or removed.

 
  

  
 
 

 
 

 
 

  

 
 
 

 
 
 

 
 

Local hosts
file with WINS

browsing

° The ad rninislrator must update the local
hosts tile if domains are added or
removed.

' The administrator cannot control which
computers appear in SEE; all computers
in the NT domain are displayed.

° On slower connections. this method is

slower than other methods because a list

of computers must be sent to the client.

 

   

  
  

  

You are not limited to using only one method for configuring SEE. You can use a
combination of the various methods. For example:

- Use WINS browsing for some domains, and explicitly list hosts for other
domains -

.0R_

- Use multiple remote hosts files
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.03-

- Specify some computers in a local hosts file and others in a remote
hosts file.

SEE PROPERTIES

To access information about the current configuration of SEE’. or to make
“changes to that configuration, right-click the Extranet Neighborhood icon and
click Properties. or click View l Options in any open SEE window. The Extra-
net Neighborhood Properties window will appear with the General tab
selected.

THE GENERAL TAB

The General tab displays information about the current configuration of SEE.

THE LOCAL TAB

The Local tab displays the computers that are listed in the local hosts file.
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inqrhrawsabtsi it
BOBKA [not browsable}
T ES T [n at brow sable]

T FIUSTDDMAIN [not biowsablel
WUFlKGFlClUP [not biowsablel

If you have specified a host in the local hosts file, you can add, edit, or remove
computers or domains that appear in the Local tab. it you have specified hosts
in the remote hosts file, they will not appear in this tab. To edit hosts in the .

remote hosts file. you must copy the file to your Av-entail Connect directory, edit
it, and then replace it in the remote hosts directory.

if you are using the WINS browsing mode, the individual computer names will
not appear. Any hosts specified in remote hosts files, including WINS servers,
will not appear in this tab.

The Add Host and Add Domain buttons allow you to add additional computers
or domains in the Add Host to Aventail dialog box and the Windows Domain
dialog box.

If no computers or domains appear in your Local tab. check the Remote tab. it
is possible that your network administrator has configured Extranet Neighbor-
hood with only a remote hosts file. '

The Search feature can automatically browse available computers in local or
remote domains and populate your local hosts file. Alternatively. you can enter .
the names of the hosts files manually.

.4ventai.-‘ Connect 3. 1/2. 6 Administrator's Guide - 102
 

 

Petitioner Apple Inc. — Exhibit 1022, p. 324



Petitioner Apple Inc. - Exhibit 1022, p. 325

Utilities Reference Guide

NOTE: To view your domains, double—click the Extranet Neighborhood
icon on your desktop. To reioad the hosts files in the Extranet
Neighborhood domains window, press the F5 key

NOTE: "in the Local tab, “browsable" domains do not show individual
computers in them.

 
Hosts File Locking

if the controls in this window are disabled (dimmed), then the hosts file has been
‘‘locked.'' The network administrator determines which, if any. hosts files are
locked.

You can lock and unlock files from any Extranet Neighborhood Properties tab.
- To look a tile, use the Ctr1+L command.

- To unlock a file. use the Ctrl-I-U command.

Windows Domain Dialog Box

To open the Windows Domain dialog box, click Add Domain in the Extranet
Neighborhood Properties 1 Local tab.

‘u-uh:r'u'!'m-us |.'|:m:mm

  
For each domain. you can either specify the WINS server names or specify each
individual host that should appear in the domain. Listing WINS servers will result
in a smaller, more manageable hosts file. You must add a domain before you
can add hosts to that domain.
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To make the specified domain "browsable." enter WINS server information in the
Primary WINS Server box and, if desired. the Secondary WINS Server box. In
both of these boxes, you can enter either the server's IP address or its fully qual-
ified host name. You must also select the Make domain browsable check box.
If you do not select the Make domain browsable check box, Extranet Neighbor-
hood will display only those computers in the local or remote hosts file, even if
you have specified a WINS server. _ -

NOTE: To use the browsing mode fora domain, you must specify the
domains WINS serve-r{s) in the hosts fife. You must speciijr the
WW3 server(s) only if you want‘ to use the browsing mode.

 

To view your domains, double-click the Extranet Neighborhood icon on your
desktop. To reload the hosts files in_ this screen, press the F5 key.

Add Host to Aventait Dialog Box

-To open the Add Host to Aventail dialog box, click Add Host on the Ektranet
Neighborhood Properties | Local tab.

 
Aventail Connect automatically places hosts within the domain that is selected
when you click Add Host. Select the correct domain before clicking Add Host.
You must specify a domain before you can add hosts to that domain.

In the Host name or IP address box. be sure to enter the servers Internet
address, not its Windows machine name.

THE REMOTE TAB

If the network administrator has configured Extranet Neighborhood to use a
remote hosts file, this tab displays the information about the currently configured
remote hosts file{s). Server name, host name or address. pathname, and user-
name are all configurable through the Remote tab.
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; Ifsctnel ea-;hnr.:l1 F'l'Eu-

Remote hosts files are always used in conjunction with a local hosts file. when
you add a remote hosts file to the list, Extranet Neighborhood adds the path to
the local hosts file. Extranet Neighborhood always has a single local hosts file;
this file can include references to multiple remote hosts files.

The most common configuration is one remote hosts file (with all domains and
hosts in the remote hosts file) and one local hosts file that contains a pointer to
the remote hosts file. If you want users to share a oommon hosts file. and if you
_want to simplify administration, use a remote hosts file.

To add entries to the list of remote hosts files. click Add. The Remote Hosts File
dialog box appears. and you can type the names of the remote hosts file(s) you
want to add.

NOTE: To access remote hosts files, Aventail Connect must be running
and configured correctly. 

Remote Hosts File Dialog Box

To open the Remote Hosts File dialog box, click Add on the Remote tab.
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When entering the Universal Naming Convention (U NC) filenarne of the remote
hosts file that you are adding, note that the [SERVER] name is the Windows
machine name, not its IP address or hostname.

In the Host name or IP address of Server box. be sure to enter the server's
Internet address. not its Windows machine name.

NOTE: Extranet Neighborhood ignores any remote hosts files that it can-
not access.
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 Troubleshooting 

Ayentail Connect-related problems tend to fall into four categories: installation,
Network Connectivity. Configuration, and Application and TCPIIP Stack interop-
erability, -

AVENTAIL CONNECT INSTALLATION PROBLEMS

-when the instructions in "Installing" in the Administrators Guide are followed.
Aventail Connect installation problems rarely occur. When they do occur, they
are often the result or:

- Toolbars, virus-checking utilities, or other Windows applications
running during the installation

If any of these are running during a failed installation, close them, unin-
stall Aventail Connect. reboot. and then re-install Aventail Connect.
ensuring that the toolbars, virus—che-cking utilities, or applications are
not automatically restarted when the system reboots.

- Insufficient RAM or free space on the volume to which Aventait
Connect is being installed

If you suspect either of these as the cause of a failed installation,
increase the available resources and retry the installation.

- Corrupted Aventail Connect installation media, or corrupted or
incomplete FTP of Aventail Connect self-extracting, executable
installation file

If you suspect corrupted Aventail Connect installation diskettes as the

cause of a failed installation. Contact Aventail Technical Support
(206.215.007B) for assistance in determining whether the files on the
diskettes may have been corrupted and whether Aventail or your ven-
dor must supply replacement diskettes.

If you suspect a corrupted or incomplete FTP transfer of Aventail Con-

nect installation files obtained over the Internet. retry the transfer, taking
care to ensure that the FTP client is in binary mode and confirm that the
transfer completes normally. Contact Aventail Technical Support to con-
firm that the byte size of the transferred installation file is correct.

- Installation to a workstation on which Aventail Connect was run-
ning or from which a previous version of Aventail Connect was not
completely uninstalled

it you suspect either of these circumstances as the cause of a failed
installation, contact Aventail Technical Support.
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- Installation script errors

Aventail Connect is installed with lnstaliShield_ If Instailshield reports
errors during a failed installation. note the text of the error messages
and the specific circumstances in which they occurred and contact
Aventail Technical Support.

NETWORK CONNECTIVITY PROBLEMS

Before Aventail Connect can successfully redirect Vtfinsock application connec-
tions: .

1. The workstation on which Aventail Connect is installed must also have a prop-
erty installed, Winsock-compatible, TCPIIP stack running on it.

This installation can be confirmed by successfully pinging the IP address of
the workstation, from the workstation itself. using a Wlnsock ping application.
If this test fails, the failure must be corrected before Aventail Connect can be
tested and before Aventail Technical Support can provide assistance.

2. Basic TC PIIP network connectivity must exist between the client workstation
on which Aventail Connect is installed and the extranet (SOCKS) server(s) to
which it is configured to redirect connections.

This connectivity can be confirmed by successfully pinging the extranet
server(s) by IP address, from the client workstation. If this test fails, the failure
must be corrected before Aventail Connect can be tested and before Aventail
Technical Support can provide assistance.

3. Basic TC PIIP network connectivity mu st also exist between the extranet
serveris) and the network host(s) to which the extranet-server(sJ are expected
to proxy connections. -

This connectivity can be confirmed by successfully pinging the network
host(s), by IP address, from the extranet server(s). If this test fails, the failure
must be corrected before Aventail Connect can be tested and before Aventail
Technical Support can provide assistance.

AVENTAIL CONNECT CONFIGURATION PROBLEMS

This section addresses troubleshooting of simple Aventail Connect configuration
problems. Troubleshooting complex Aventail Connect configuration problems is
beyond the scope of this section.

it is easiest to troubleshoot Aventail Connect configuration problems by creating
and testing simple Aventail Connect configuration files, such as those that may
be created with the Aventail Connect configuration wizard. However. all refer-
ences to host and domain names must be removed from configuration files cre-
ated with the wizard, before testing, to defer possible name resolution
complications until the files can be demonstrated to work with IP addresses
alone.
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NOTE: The iP address and SOCKS port number of the extranet
(SOCKS) sen-*er(s) to which Aventai? Connect must connect must
be known before troubiesnooting Aventail Connect configuration
probiems. Neitnemventaii Connect, nor Aventaii Technicai Sup-
port, can discover the IP address or port number of the extranet
sen/er(s).

when troubleshooting Aventail Connect configuration problems; confirm that the
Aventail Connect configuration file that is currently selected in the Configura-
tion File dialog box is the one intended for testing.

After selecting a configuration “file to test, open the Aventail Connect Config Tool
and:

1. Confirm that the extranet server has been correctly identified by IP address.’

Click the Servers tab, select the server alias and then click Edit.... Compare
the IP address in the Hostname or IP box with that of the extranet server.

If the extranet server is a SOCKS v5 server, click SOCKS v4 in the "SOCKS
Version” area of the Servers tab. Then click Detect Version. The selection
will revert to SOCKS v5. indicating that Aventail Connect detected a SOCKS
v5 sewer running at the IP address specified in the Hostname or IP box.

If, on the other hand, the extranet server is a SOCKS v4 server, click SOCKS
v5 in the "SOCKS Version” area. Then click Detect Version.‘ The selection
will revert SOCKS v4. indicating thatAventail Connect detected _a SOCKS v4
server running at the IP address specified in the Hostname or IF’ box.

If Detect Version fails to detect an extranet server of either version, it is pos-
sible that no extranet server is running on the host identified in the Hostname
or IP box. Contact your extranet server administrator to confirm that the extra-
net server is running at the address specified.

2. Confirm that all Aventail Connect authentication modules are enabled.

Click the Authentication tab and confirm that the "traffic light" icons for all of
the authentication Modules are green, indicating that the modules are
enabled. Enabling all the modules configures Aventail Connect to attempt any
form of authentication demanded by the extranet server or null (no) authenti-
cation. Note the form of authentication demanded by the extranet server and,
if necessary, obtain the proper authentication credentials. such as an extranet
server username and password, from the extranet server administrator.

3. Confirm that the network hosts to which the extranet server is expected to
proxy connections are within a redirected destination.

Click the Destinations tab, select the destination that includes the network
host to which the extranet server is expected to proxy connections. and then
ctick Edit.... Confirm that the definition of the Destination includes the network
host.

Next. click the Redirection Rules tab. Confirm that connections to the Desti-
nation are configured to be redirected by the extranet server.
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Troubleshooting

After making any necessary changes to the Aventail Connect configuration.
restart Aventail Connect and then restart any Winsock applications before
testing the new configuration.

APPLICATION AND TCP/lP STACK INTEROPERABILITY

PROBLEMS
Aventail Connect is intended to "automatically socksify” all '‘well- behaved" Win-
Sock applications. Occasionally, you may find Winsock applications that Aven-
tail Connect does not socksify, due to interoperability problems with the
application.

Aventail Connect is also intended to run on all Winsock-compliant Microsoft
Windows TCPIIP stacks. Aventail Connect does not alter or replace Winsock or
any other core TCPIIP components (files) provided by the operating system.
Occasionally, you may find Winsock stacks on which Aventail Connect does not
run as expected, due to interoperability problems with the stack.

If you suspect an application or stack interoperability problem. report it to Aven-
tail Technical Support. Aventail will make every reasonable effort to resolve
interoperabitity problems.

AVENTAIL CONNECT TRACE LOGGING

Aventail Connect includes a Logging Tool for tracing Aventail Connect and Win-
Sock activity. Aventail Connect traces are often useful in troubleshooting Aven-
tail Connect network. extranet server, andwnsock application interoperability
problems. Aventail Technical Support engineers may request that you perform a
verbose trace, log it to a tile, and e-mail it to them as an attachment.

.T.e_ f_'!.'.‘.._3'.!._P+Y?"*3i'._¢?'?l1?9? t-'a<=¢..

1, Close any Winsock applications that are running on the workstation.

2. If Aventail Connect is running. close it and then restart it.

3. Start an Aventail Connect trace.

In vvndows 95, Windows 98, and Umndows NT 4.0. right-click the minimized
Aventail Connect icon in the system tray. and click Logging Tool. in Win-
dows 3.1, ‘Windows for Workgroups 3.11. and Windows NT 3.51. double-click
the Logging Tool icon in the Aventail program group. The Aventail Connect
Logging Tool window will open, as illustrated in Figure 1, below.

4. On the Log menu. confirm that the Trace command is checked. If it is not,
ctick Trace to enable it.
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Troubleshooting

To save an Ayentail Connect tra_ce to a file

1, On the Log menu. confirm that the Log To File command is checked. If it is
not, click Log To File to enable it.

ERROR MESSAGES

Occasionally, you may see an error message while running Aventail Connect.
The following table explains some of the more common Aventail Connect error
messages.

  
 
 

 Setup has determined that your SETUP: To install Aventail Connect 3.1, you must
computer does not have this first install the Microsoft winsock 2 upgrade.
support and needs the \MnSock 2

patch, available from Microsoft. | .
The patch is available for SETUP: Location of the Microsoft winsock 2
download on the Microsoft Web upgrade.
site, at httptli
www.microsofl.coml

Windows95fdown|oadsl

contentsfwuadmintoolsf

s_wunetworkingtooIsl

W95Sockets2ldefault.asp.
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Troubleshooting

 

 
 

 SETUP: On Windows NT machines. you must
have administrative privileges to install or uninstall
Aventail Connect.

SETUP: Retain the previous installation of

Aventail Connect by pressing NO. Replace with
the newer installation by pressing YES.

 You must have administrator

privileges to install.
   
 

 
 

 
 
  

 
 

Setup has detected that a previous

installation of {.. ..) is present.
Would you like to continue and

- upgrade to (....)? Pressing N0 will

leave your existing installation
intact and will cause Setup to

terminate. J

 
  

  
  
   package does not contain the " SETUP:_Setup--cannot find the necessary Av_ent—aiI

necessary 3.1 files. Please contact Connect 3.1 lites.
your administrator.

 
 

   
 

 

 
 

  The package does not contain the SETUP: Setup cannot find the necessary Aventail
necessary 2.3 files. Please contact Connect 2.6 files.
your administrator.

  
 

 
 
 

CUSTOMIZER: Create a new setup tile, or retain a
previous setup file.

The file you have selected is not a

valid Aventail setup file. Would you
like to create it? 

 
  
 

CUSTOMIZER: Must run Customizer from a valid

Customize directory.
 

 
 

Cuslomizer must be run from a

valid Customize directory. Your
changes will not be saved.

The Connect executable does not I The specified signature is not valid.
have a valid Aventail digital
signature.

 
  

 
.._.._ ._... ._...__. [.._....j

Connect cannot find your license Aventail Connect cannot find a valid Aventail
file, aventailalf. - license file, aventaitalf.

 

    Connect cannot load because your
license file does not contain a
license.

The license file exists. but it contains no license.

 
  
 

l___

This version of Connect does not Aventail Connect 2.5 does not support HTTP
support HTTP servers. servers.

 

 
 

  
  

REPORTING AVENTAIL CONNECT PROBLEMS

Report Aventail Connect problems to Aventail Technical Support by completing
and submitting an Online Support form on the Support page of the Aventail Web
site, http:llwww.aventail.com.
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_ Glossary

Glossary

ALIAS

User-friendly name for destination network or host computer.

AUTHENTICATION

A method for identifying a user in order to establish access to a system
resource or network. Authentication information such as usernamelpassword
is entered via prompts.

CERTIFICATE

A certificate is essentially an electronic "statement" which verifies that a cer-
tain RSA public key is associated with a particular name. Certificates are
issued by a Certification Authority (CA).

CLIENT

A program or Internet service that sends commands to and receive informa-
tion from a corresponding program known as a server. Most Internet services
run as client/server programs.

CONFIGURATION FILE

A file of information containing traflic redirection rules used to determine if
and how SOCKS redirection should occur.

CREDEN TIALS

Credentials include the information (such as usernameip-assword) that you
enter when establishing a connection to a SOCKS server requiring user
authentication. '

DOMAIN

Internet name for a network or computer system.

ENCRYPTION

A security procedure that converts data into a format which can be read only
by the intended recipient computer.

EXTRANET _

A network that is partially accessible to outsiders.

FIREWALL

Software or hardware barriers that control the flow of information to Private
networks.
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Grossary

GATEWAY

A communications devicerprogram that passes data between networks.

HACKER

A person who enjoys using computers and has a thorough understanding of
how they work. as well as the networks they run on. Often used to mean
"cracker." the correct term for someone who accesses computer systems
without authorization.

HOST

A server connected to the Internet.

IETF

Internet Engineering Task Force: An open community of network designers,
vendors. etc. who resolve protocol and architectural issues for the quickly
evolving Internet.

INTERNET PRoTocoL (IP)

' The basic data transfer protocol used for the Internet. Information such as the
address of the sender and the recipient is inserted into an electronic "packel”
which is then transmitted.

INTRANET

A network that is internal to a company or organization.

LAN

Local area network

LAYERED SERVICE PROVIDER (LSP)

A program that is installed just below Wtnsock 2, allowing two-way communi-
cation between the Winsock 2-compatible application and the underlying
TCPIIP stack. An LSP can redirect andior change data before sending the
data to the operating systems TCPHIP stack for transport over the network.

LOG WINDOW

The window of the Logging Tool which shows alerts. messages, and warnings
generated by Aventail Connect.

PING

A utility that determines if a remote host computer is up. ping sends data
packets to the host. lf the packets are not returned. the host is down.

PRO TOCOL

Rules and procedures used to exchange information between networks and
computer systems.
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Glossary -

REDIRECTION RULES

Rules defined in the configuration file which specify how network requests are
routed to SOCKS servers.

ROUTER

A device that transmits traffic between networks

SERVER

A networked computer that shares resources with other computers. Servers
"serve up” information to clients.

SMB

Server Message Block. A message format used by DOS and ‘Mndows for
sharing fites, directories. and other resources. -

SOCKS

SOCKS is a security protocol. it acts as a proxy mechanism that manages the
flow and security of data traffic to and from your local area network or intra-
net.

SSL

Security Sockets Layer. An authentication and encryption protocol.

TRACEROUTE

_ A utility that traces the routing of data over the lntemet to a specific computer.
Traceroute sends a data packet and then lists the intermediate host comput-
ers that it traverses on it's way to the destination machine.

TRANSMISSION CONTROL PROTOCOL (TOP)

A means of sending data over the internet with guaranteed delivery.

TRANSMISSION CONTROL PROTOCOLNNTERNET PROTOCOL (TCPIIP)
A suite of protocols the Internet uses to provide for services such as e-mail,
ftp, and telnet.

Uses DATAGRAM PROTOCOL (UDP)

A means of sending data over the Internet without guaranteed delivery. Also
known as "con nectionless” protocol, it is used for data such as RealAudio®.

UNIVERSAL mums CONVENTION lUNC)

A way of accessing a file or directory on another computer. For example: If
-hostrshareldirectoryrfile (“share" refers to the alias used to make the resource
available.)

VIRUS

A self-replicating code segment that can infect a computer or network, caus-
ing minor to major damage
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Glossary

VPN

V-irtuat Private Network: A secure channel used to transmit data over a pubtic
network

WINSOCK

Windows Sockets. A Windows component that connects a Windows PC to
. the Intemet using TCPIIP.

WORKSTATION

Any computer connected to a network.

X.509

An ISO format standard for client and server certificates.
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